Microsoft PowerPoint 2010

Build exactly the skills you need. Learn at the pace you want.

Joyce Cox and Joan Lambert
Contents

Introducing Microsoft PowerPoint 2010 ......................................................... ix
Modifying the Display of the Ribbon .............................................................. xiii
Features and Conventions of This Book ......................................................... xix
Using the Practice Files .................................................................................. xxi
Getting Help .................................................................................................... xxv

Part 1  Basic Presentations

1  Explore PowerPoint 2010 3
   Working in the User Interface ................................................................. 4
   Creating and Saving Presentations ......................................................... 18
      Sidebar: Compatibility with Earlier Versions ....................................... 24
   Opening, Moving Around in, and Closing Presentations ....................... 25
   Viewing Presentations in Different Ways ................................................. 28
   Key Points ................................................................................................. 35

2  Work with Slides 37
   Adding and Deleting Slides ................................................................. 37
   Adding Slides with Ready-Made Content .............................................. 40
      Sidebar: Working with Slide Libraries ................................................. 45
      Sidebar: Exporting Presentations as Outlines ..................................... 46
   Dividing Presentations into Sections .................................................... 46
   Rearranging Slides and Sections ............................................................ 50
   Key Points ................................................................................................. 53

What do you think of this book? We want to hear from you!
Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources for you. To participate in a brief online survey, please visit:

microsoft.com/learning/booksurvey
3 Work with Slide Text

Entering Text in Placeholders ................................................................. 56
Adding Text Boxes .............................................................................. 59
  Sidebar: Changing the Default Font for Text Boxes ....................... 66
Editing Text ......................................................................................... 66
  Sidebar: About the Clipboard .......................................................... 71
Correcting and Sizing Text While Typing ........................................... 72
Checking Spelling and Choosing the Best Words ............................... 78
  Sidebar: Researching Information and Translating Text ................. 83
Finding and Replacing Text and Fonts ................................................ 84
Key Points.......................................................................................... 87

4 Format Slides

Applying Themes .............................................................................. 89
Using Different Color and Font Schemes .......................................... 92
Changing the Slide Background ......................................................... 95
Changing the Look of Placeholders .................................................. 99
Changing the Alignment, Spacing, Size, and Look of Text ................... 103
  Sidebar: Non–Color Scheme Colors ............................................... 110
Key Points ......................................................................................... 111

5 Add Simple Visual Enhancements

Inserting Pictures and Clip Art Images ............................................. 114
Inserting Diagrams ........................................................................... 120
  Sidebar: Graphic Formats ............................................................... 121
  Sidebar: Converting Existing Bullet Points into Diagrams ............. 128
Inserting Charts ............................................................................... 128
Drawing Shapes ............................................................................... 136
  Sidebar: Connecting Shapes .......................................................... 144
Adding Transitions .......................................................................... 145
Key Points ......................................................................................... 149
6 Review and Deliver Presentations

Setting Up Presentations for Delivery .................................................. 152
Previewing and Printing Presentations .................................................. 157
Preparing Speaker Notes and Handouts ................................................. 161
Sidebar: Enhanced Handouts ................................................................. 167
Finalizing Presentations ................................................................. 168
Sidebar: Setting Up Presenter View ....................................................... 174
Delivering Presentations ................................................................. 175
Key Points .......................................................................................... 178

Part 2 Presentation Enhancements

7 Add Tables

Inserting Tables .............................................................................. 181
Formatting Tables ............................................................................. 185
Inserting and Updating Excel Worksheets ........................................... 188
Key Points .......................................................................................... 193

8 Fine-Tune Visual Elements

Editing Pictures ............................................................................... 196
Customizing Diagrams ..................................................................... 203
Formatting Charts ............................................................................ 207
Arranging Graphics .......................................................................... 214
Sidebar: Alt Text ................................................................................ 220
Key Points .......................................................................................... 221

9 Add Other Enhancements

Adding WordArt Text ......................................................................... 223
Inserting Symbols and Equations ......................................................... 227
Sidebar: Setting Math AutoCorrect Options ......................................... 234
Inserting Screen Clippings ................................................................. 235
Creating Hyperlinks ........................................................................... 237
Sidebar: Attaching the Same Hyperlink to Every Slide ......................... 241
Attaching Actions to Text or Objects ................................................. 242
Key Points .......................................................................................... 247
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>10</strong> Add Animation</td>
<td>249</td>
</tr>
<tr>
<td>Using Ready-Made Animations</td>
<td>250</td>
</tr>
<tr>
<td>Customizing Animation Effects</td>
<td>254</td>
</tr>
<tr>
<td>Key Points</td>
<td>261</td>
</tr>
<tr>
<td><strong>11</strong> Add Sound and Movies</td>
<td>263</td>
</tr>
<tr>
<td>Inserting and Playing Sounds</td>
<td>263</td>
</tr>
<tr>
<td>Inserting and Playing Videos</td>
<td>268</td>
</tr>
<tr>
<td>Sidebar: Inserting Videos from Web Sites</td>
<td>275</td>
</tr>
<tr>
<td>Key Points</td>
<td>276</td>
</tr>
<tr>
<td><strong>Part 3</strong> Additional Techniques</td>
<td></td>
</tr>
<tr>
<td><strong>12</strong> Share and Review Presentations</td>
<td>279</td>
</tr>
<tr>
<td>Collaborating with Other People</td>
<td>280</td>
</tr>
<tr>
<td>Sidebar: Broadcasting Presentations</td>
<td>282</td>
</tr>
<tr>
<td>Saving Presentations in Other Formats</td>
<td>283</td>
</tr>
<tr>
<td>Sending Presentations Directly from PowerPoint</td>
<td>289</td>
</tr>
<tr>
<td>Sidebar: Adding Digital Signatures</td>
<td>292</td>
</tr>
<tr>
<td>Password-Protecting Presentations</td>
<td>292</td>
</tr>
<tr>
<td>Sidebar: Information Rights Management</td>
<td>295</td>
</tr>
<tr>
<td>Adding and Reviewing Comments</td>
<td>296</td>
</tr>
<tr>
<td>Merging Presentation Versions</td>
<td>299</td>
</tr>
<tr>
<td>Key Points</td>
<td>303</td>
</tr>
<tr>
<td><strong>13</strong> Create Custom Presentation Elements</td>
<td>305</td>
</tr>
<tr>
<td>Creating Theme Colors and Fonts</td>
<td>306</td>
</tr>
<tr>
<td>Viewing and Changing Slide Masters</td>
<td>310</td>
</tr>
<tr>
<td>Creating Slide Layouts</td>
<td>318</td>
</tr>
<tr>
<td>Saving Custom Design Templates</td>
<td>326</td>
</tr>
<tr>
<td>Key Points</td>
<td>329</td>
</tr>
</tbody>
</table>
Microsoft PowerPoint 2010 is a full-featured presentation program that helps you quickly and efficiently develop dynamic, professional-looking presentations and then deliver them to an audience. You can use PowerPoint to:

- Introduce an idea, proposal, organization, product, or process with professionally designed, high-impact slides.
- Use themes, galleries of styles, and formatting options to achieve the right combination of colors, fonts, and effects.
- Bolster your arguments by easily adding pictures, shapes, and fancy display text.
- Convey numeric data in easy-to-grasp ways with styled tables or visually compelling charts.
- Use the SmartArt Graphics tool to create sophisticated diagrams that reflect processes, hierarchies, and other relationships.
- Create custom themes, designs, and layouts so that your presentations have a unique look and feel.
- Collaborate with colleagues, giving and receiving feedback to ensure the best possible presentation.

PowerPoint 2010 builds on previous versions to provide powerful tools for all your presentation needs. This introduction provides an overview of new features that we explore throughout the book.

**New Features**

If you’re upgrading to PowerPoint 2010 from a previous version, you’re probably most interested in the differences between the old and new versions and how they will affect you, as well as how to find out about them in the quickest possible way. The following sections list new features you will want to be aware of, depending on the version of PowerPoint you are upgrading from.
If You Are Upgrading from PowerPoint 2007

If you have been using PowerPoint 2007, you might be wondering how Microsoft could have improved on what seemed like a pretty comprehensive set of features and tools. The list of new features includes the following:

- **The Backstage view** Finally, all the tools you need to work with your files, as opposed to their content, really are accessible from one location. You display the Backstage view by clicking the File tab, which replaces the Microsoft Office Button at the left end of the ribbon.

- **Customizable ribbon** The logical next step in the evolution of the command center introduced with PowerPoint 2007: Create your own tabs and groups to suit the way you work.

- **A window for each presentation** You no longer display all presentations in the same window, so you can arrange open presentations for easy comparison or work on different presentations at the same time.

- **Reading view** This new way to preview presentations makes it easy to quickly check the effect of one or two changes.

- **Presentation videos** Now turning a presentation into a Windows Media Video is a simple matter of saving in that format.

- **Paste preview** No more trial and error when moving items to new locations. Preview what an item will look like in each of the available formats, and then pick the one you want.

- **Animation Painter** If you spend time developing a complex animation for one object, you can now copy the animation settings to another object with a few mouse clicks.

- **New themes and transitions** Adding pizzazz to your presentations is just a matter of applying a professional-looking theme or a snazzy dynamic-content transition.

- **Graphics editing** Found the perfect picture, but its colors or style aren’t quite right for your presentation? Now after inserting a picture, you can edit it in new ways. In addition to changing color, brightness, and contrast, you can remove the background and, most exciting of all, apply artistic effects that make it appear like a watercolor, pencil drawing, or pastel sketch.
- **Improved cropping** Not only can you drag crop handles to manually crop a picture but you can also apply a built-in cropping ratio and then move the cropping "window" around over the picture until you get precisely the part you want.

- **Text effects** WordArt has had a makeover. You can still use WordArt to create distinctive headlines, but now you can use its effects on any selected text.

- **Screenshots** You no longer need to go outside of PowerPoint when you want to insert a screenshot into a slide. This capability is now built into Word.

- **Improved SmartArt Graphics tool** A whole new category has been added to SmartArt so that you can include pictures as well as text in your diagrams.

- **Video tools** Found a perfect video, but it is too long to include in a presentation? Now you can insert the video and then use the video editing tools built into PowerPoint to trim and format it. You can also insert a link to a video on a Web site into a slide.

- **Version merging** You can merge two versions of the same presentation and accept or reject changes.

- **Team collaboration** Team members can now work simultaneously on a presentation stored on a Microsoft SharePoint 2010 server or in Windows Live SkyDrive.

- **Broadcasting** You can review a presentation with colleagues via the Web by working through a free broadcasting service. Your colleagues can view the presentation in their Web browsers and give feedback via a conference call.

- **Language support** If you need to conduct business internationally across language lines, you can easily tailor the language of your working environment. You can also use new translation tools to collaborate with team members in other countries.

- **Unsaved file recovery** How many times have you responded No without thinking to the "save changes" message when closing files, only to find that you have discarded work you wanted to keep? PowerPoint now preserves your unsaved files for a period of time, allowing you to recover them if you need them.
If You Are Upgrading from PowerPoint 2003

In addition to the features listed in the previous section, if you’re upgrading from PowerPoint 2003, you’ll want to take note of the new features that were introduced in PowerPoint 2007. The 2007 upgrade provided a more efficient working environment and included a long list of new and improved features, including the following:

- **The Microsoft Office Fluent Ribbon**  No more hunting through menus, submenus, and dialog boxes. This new interface organizes all the commands most people use most often, making them quickly accessible from tabs at the top of the program window.

- **Live Preview**  See the effect of a style, theme, or other option before you apply it.

- **Custom layouts**  Easily create your own layouts with placeholders for specific objects, and then save them for use in other presentations.

- **SmartArt Graphics tool**  Use this awesome new diagramming tool to create sophisticated diagrams with 3-D shapes, transparency, drop shadows, and other effects.

- **Improved charting**  Enter data in a linked Microsoft Excel worksheet and watch as your data is instantly plotted in the chart type of your choosing.

- **Slide libraries**  Share slide content with team members in a special SharePoint library for presentations and slides.

- **Presentation cleanup**  Have PowerPoint check for and remove comments, hidden text, and personal information stored as properties before you declare a presentation final.

- **New file format**  The new Microsoft Office Open XML Formats reduce file size and help avoid loss of data.

Let’s Get Started!

We’ve been working with PowerPoint since its debut, and each version has offered something that made daily presentation creation a little easier. Microsoft PowerPoint 2010 is no exception, and we look forward to showing you around.
Modifying the Display of the Ribbon

The goal of the Microsoft Office 2010 working environment is to make working with Office files—including Microsoft Word documents, Excel workbooks, PowerPoint presentations, Outlook e-mail messages, and Access databases—as intuitive as possible. You work with an Office file and its contents by giving commands to the program in which the document is open. All Office 2010 programs organize commands on a horizontal bar called the *ribbon*, which appears across the top of each program window whether or not there is an active document.

A typical program window ribbon.

Commands are organized on task-specific tabs of the ribbon, and in feature-specific groups on each tab. Commands generally take the form of buttons and lists. Some appear in galleries. Some groups have related dialog boxes or task panes that contain additional commands.

Throughout this book, we discuss the commands and ribbon elements associated with the program feature being discussed. In this topic, we discuss the general appearance of the ribbon, things that affect its appearance, and ways of locating commands that aren't visible on compact views of the ribbon.

**See Also** For detailed information about the ribbon in Microsoft PowerPoint, see “Working in the User Interface” in Chapter 1, “Explore PowerPoint 2010.”

**Tip** Some older commands no longer appear on the ribbon, but are still available in the program. You can make these commands available by adding them to the Quick Access Toolbar. For more information, see “Customizing the Quick Access Toolbar” in Chapter 15, “Customize PowerPoint.”
Dynamic Ribbon Elements

The ribbon is dynamic, meaning that the appearance of commands on the ribbon changes as the width of the ribbon changes. A command might be displayed on the ribbon in the form of a large button, a small button, a small labeled button, or a list entry. As the width of the ribbon decreases, the size, shape, and presence of buttons on the ribbon adapt to the available space.

For example, when sufficient horizontal space is available, the buttons on the Review tab of the Word program window are spread out and you’re able to see more of the commands available in each group.

The Review tab of the Word program window at 1024 pixels wide.

If you decrease the width of the ribbon, small button labels disappear and entire groups of buttons hide under one button that represents the group. Click the group button to display a list of the commands available in that group.

The Review tab of the Word program window at 675 pixels wide.

When the window becomes too narrow to display all the groups, a scroll arrow appears at its right end. Click the scroll arrow to display hidden groups.
Changing the Width of the Ribbon

The width of the ribbon is dependent on the horizontal space available to it, which depends on these three factors:

- The width of the program window  Maximizing the program window provides the most space for ribbon elements. You can resize the program window by clicking the button in its upper-right corner or by dragging the border of a non-maximized window.

  **Tip**  On a computer running Windows 7, you can maximize the program window by dragging its title bar to the top of the screen.

- Your screen resolution  Screen resolution is the size of your screen display expressed as pixels wide × pixels high. The greater the screen resolution, the greater the amount of information that will fit on one screen. Your screen resolution options are dependent on your monitor. At the time of writing, possible screen resolutions range from 800 × 600 to 2048 × 1152. In the case of the ribbon, the greater the number of pixels wide (the first number), the greater the number of buttons that can be shown on the ribbon, and the larger those buttons can be.

  On a computer running Windows 7, you can change your screen resolution from the Screen Resolution window of Control Panel.
You set the resolution by dragging the pointer on the slider.

- The density of your screen display You might not be aware that you can change the magnification of everything that appears on your screen by changing the screen magnification setting in Windows. Setting your screen magnification to 125% makes text and user interface elements larger on screen. This increases the legibility of information, but means that less fits onto each screen.

On a computer running Windows 7, you can change the screen magnification from the Display window of Control Panel.
You can choose one of the standard display magnification options, or create another by setting a custom text size.

The screen magnification is directly related to the density of the text elements on screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms are interchangeable, and in fact are both used in the Windows dialog box in which you change the setting.) The greater the dpi, the larger the text and user interface elements appear on screen. By default, Windows displays text and screen elements at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text and screen elements to 120 dpi. You can choose a custom setting of up to 500% magnification, or 480 dpi, in the Custom DPI Setting dialog box.

You can choose a magnification of up to 200% from the lists, or choose a greater magnification by dragging across the ruler from left to right.
Adapting Exercise Steps

The screen images shown in the exercises in this book were captured at a screen resolution of 1024 x 768, at 100% magnification, and the default text size (96 dpi). If any of your settings are different, the ribbon on your screen might not look the same as the one shown in the book. For example, you might see more or fewer buttons in each of the groups, the buttons you see might be represented by larger or smaller icons than those shown, or the group might be represented by a button that you click to display the group's commands.

When we instruct you to give a command from the ribbon in an exercise, we do it in this format:

- On the **Insert** tab, in the **Illustrations** group, click the **Chart** button.

If the command is in a list, we give the instruction in this format:

- On the **Page Layout** tab, in the **Page Setup** group, click the **Breaks** button and then, in the list, click **Page**.

The first time we instruct you to click a specific button in each exercise, we display an image of the button in the page margin to the left of the exercise step.

If differences between your display settings and ours cause a button on your screen to look different from the one shown in the book, you can easily adapt the steps to locate the command. First, click the specified tab. Then locate the specified group. If a group has been collapsed into a group list or group button, click the list or button to display the group's commands. Finally, look for a button that features the same icon in a larger or smaller size than that shown in the book. If necessary, point to buttons in the group to display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you read and work through the exercises in the book.
This book has been designed to lead you step by step through all the tasks you’re most likely to want to perform in Microsoft PowerPoint 2010. If you start at the beginning and work your way through all the exercises, you will gain enough proficiency to be able to create and work with most types of PowerPoint presentations. However, each topic is self contained. If you have worked with a previous version of PowerPoint, or if you completed all the exercises and later need help remembering how to perform a procedure, the following features of this book will help you locate specific information:

- **Detailed table of contents** Search the listing of the topics and sidebars within each chapter.
- **Chapter thumb tabs** Easily locate the beginning of the chapter you want.
- **Topic-specific running heads** Within a chapter, quickly locate the topic you want by looking at the running heads at the top of odd-numbered pages.
- **Glossary** Look up the meaning of a word or the definition of a concept.
- **Keyboard Shortcuts** If you prefer to work from the keyboard rather than with a mouse, find all the shortcuts in one place.
- **Detailed index** Look up specific tasks and features in the index, which has been carefully crafted with the reader in mind.

You can save time when reading this book by understanding how the *Step by Step* series shows exercise instructions, keys to press, buttons to click, and other information.
<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SET UP</strong></td>
<td>This paragraph preceding a step-by-step exercise indicates the practice files that you will use when working through the exercise. It also indicates any requirements you should attend to or actions you should take before beginning the exercise.</td>
</tr>
<tr>
<td><strong>CLEAN UP</strong></td>
<td>This paragraph following a step-by-step exercise provides instructions for saving and closing open files or programs before moving on to another topic. It also suggests ways to reverse any changes you made to your computer while working through the exercise.</td>
</tr>
<tr>
<td><strong>1</strong></td>
<td>Blue numbered steps guide you through hands-on exercises in each topic.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td></td>
</tr>
<tr>
<td><strong>1</strong></td>
<td>Black numbered steps guide you through procedures in sidebars and expository text.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td></td>
</tr>
<tr>
<td><strong>See Also</strong></td>
<td>This paragraph directs you to more information about a topic in this book or elsewhere.</td>
</tr>
<tr>
<td><strong>Troubleshooting</strong></td>
<td>This paragraph alerts you to a common problem and provides guidance for fixing it.</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>This paragraph provides a helpful hint or shortcut that makes working through a task easier.</td>
</tr>
<tr>
<td><strong>Important</strong></td>
<td>This paragraph points out information that you need to know to complete a procedure.</td>
</tr>
<tr>
<td><strong>Keyboard Shortcut</strong></td>
<td>This paragraph provides information about an available keyboard shortcut for the preceding task.</td>
</tr>
<tr>
<td><strong>Ctrl+B</strong></td>
<td>A plus sign (+) between two keys means that you must press those keys at the same time. For example, “Press Ctrl+B” means that you should hold down the Ctrl key while you press the B key.</td>
</tr>
<tr>
<td><strong>Images</strong></td>
<td>Pictures of buttons appear in the margin the first time the button is used in a chapter.</td>
</tr>
<tr>
<td><strong>Black bold</strong></td>
<td>In exercises that begin with SET UP information, the names of program elements, such as buttons, commands, windows, and dialog boxes, as well as files, folders, or text that you interact with in the steps, are shown in black, bold type.</td>
</tr>
<tr>
<td><strong>Blue bold</strong></td>
<td>In exercises that begin with SET UP information, text that you should type is shown in blue bold type.</td>
</tr>
</tbody>
</table>
Using the Practice Files

Before you can complete the exercises in this book, you need to copy the book’s practice files to your computer. These practice files, and other information, can be downloaded from the book’s detail page, located at:

http://go.microsoft.com/fwlink/?LinkId=192149

Display the detail page in your Web browser and follow the instructions for downloading the files.

**Important** The Microsoft PowerPoint 2010 program is not available from this Web site. You should purchase and install that program before using this book.

The following table lists the practice files for this book.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>File</th>
</tr>
</thead>
</table>
| Chapter 1: Explore PowerPoint 2010 | BuyingTrip_start.pptx  
DesigningColor_start.pptx  
MayMeeting_start.pptx  
SalesMeetingMay_start.pptx |
| Chapter 2: Work with Slides | Projects.pptx  
ServiceA_start.pptx  
ServiceB_start.pptx  
ServiceC_start.pptx  
ServiceD_start.pptx  
ServiceOrientation.docx |
| Chapter 3: Work with Slide Text | BuyingTripsB_start.pptx  
BuyingTripsC_start.pptx  
CommunityServiceA_start.pptx  
CommunityServiceB_start.pptx  
CommunityServiceC_start.pptx |
| Chapter 4: Format Slides | BusinessTravelA_start.pptx  
BusinessTravelB_start.pptx  
ColorDesign_start.pptx  
CompanyMeetingA_start.pptx  
CompanyMeetingB_start.pptx  
Landscaping_start.pptx |
<table>
<thead>
<tr>
<th>Chapter</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 5: Add Simple Visual Enhancements</td>
<td>Agastache.jpg</td>
</tr>
<tr>
<td></td>
<td>JournalingA_start.pptx</td>
</tr>
<tr>
<td></td>
<td>JournalingB_start.pptx</td>
</tr>
<tr>
<td></td>
<td>Penstemon.jpg</td>
</tr>
<tr>
<td></td>
<td>WaterConsumption.xlsx</td>
</tr>
<tr>
<td></td>
<td>WaterSavingA_start.pptx</td>
</tr>
<tr>
<td></td>
<td>WaterSavingB_start.pptx</td>
</tr>
<tr>
<td></td>
<td>WaterSavingC_start.pptx</td>
</tr>
<tr>
<td>Chapter 6: Review and Deliver Presentations</td>
<td>Harmony_start.pptx</td>
</tr>
<tr>
<td></td>
<td>Meeting_start.pptx</td>
</tr>
<tr>
<td></td>
<td>SavingWater_start.pptx</td>
</tr>
<tr>
<td></td>
<td>ServiceOrientationA_start.pptx</td>
</tr>
<tr>
<td></td>
<td>ServiceOrientationB_start.pptx</td>
</tr>
<tr>
<td></td>
<td>YinYang.png</td>
</tr>
<tr>
<td>Chapter 7: Add Tables</td>
<td>FinancialMeeting_start.pptx</td>
</tr>
<tr>
<td></td>
<td>NewEquipment.xlsx</td>
</tr>
<tr>
<td></td>
<td>Temperature_start.pptx</td>
</tr>
<tr>
<td></td>
<td>TemperatureFormatted_start.pptx</td>
</tr>
<tr>
<td>Chapter 8: Fine-Tune Visual Elements</td>
<td>GardenResidents_start.pptx</td>
</tr>
<tr>
<td></td>
<td>LandscapingChart_start.pptx</td>
</tr>
<tr>
<td></td>
<td>NativePlant1.jpg through NativePlant8.jpg</td>
</tr>
<tr>
<td></td>
<td>PhotoAlbumTitleSlide.pptx</td>
</tr>
<tr>
<td></td>
<td>ReorganizationMeeting_start.pptx</td>
</tr>
<tr>
<td>Chapter 9: Add Other Enhancements</td>
<td>DesertPlants_start.pptx</td>
</tr>
<tr>
<td></td>
<td>MeetingAction_start.pptx</td>
</tr>
<tr>
<td></td>
<td>Organization_start.pptx</td>
</tr>
<tr>
<td></td>
<td>OrganizationLinks_start.pptx</td>
</tr>
<tr>
<td></td>
<td>Procedures.docx</td>
</tr>
<tr>
<td></td>
<td>TemperatureCelsius_start.pptx</td>
</tr>
<tr>
<td>Chapter 10: Add Animation</td>
<td>NaturalGardeningA_start.pptx</td>
</tr>
<tr>
<td></td>
<td>NaturalGardeningB_start.pptx</td>
</tr>
<tr>
<td>Chapter</td>
<td>File</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chapter 11: Add Sound and Movies</td>
<td>AGK Cottage_start.pptx</td>
</tr>
<tr>
<td></td>
<td>Amanda.wav</td>
</tr>
<tr>
<td></td>
<td>Bird.jpg</td>
</tr>
<tr>
<td></td>
<td>Butterfly.wmv</td>
</tr>
<tr>
<td></td>
<td>HealthyEcosystemsA_start.pptx</td>
</tr>
<tr>
<td></td>
<td>HealthyEcosystemsB_start.pptx</td>
</tr>
<tr>
<td></td>
<td>Wildlife.wmv</td>
</tr>
<tr>
<td>Chapter 12: Share and Review Presentations</td>
<td>CottageShow_start.pptx</td>
</tr>
<tr>
<td></td>
<td>HarmonyReview_start.pptx</td>
</tr>
<tr>
<td></td>
<td>MeetingCompareA_start.pptx</td>
</tr>
<tr>
<td></td>
<td>MeetingCompareB_start.pptx</td>
</tr>
<tr>
<td></td>
<td>MeetingThemeA_start.pptx</td>
</tr>
<tr>
<td></td>
<td>MeetingThemeB.pptx</td>
</tr>
<tr>
<td></td>
<td>MeetingThemeC.pptx</td>
</tr>
<tr>
<td></td>
<td>ServiceProjects_start.pptx</td>
</tr>
<tr>
<td></td>
<td>WaterUse_start.pptx</td>
</tr>
<tr>
<td>Chapter 13: Create Custom Presentation Elements</td>
<td>NativePlant1.jpg through NativePlant3.jpg</td>
</tr>
<tr>
<td></td>
<td>NaturalLayout_start.pptx</td>
</tr>
<tr>
<td></td>
<td>NaturalMaster_start.pptx</td>
</tr>
<tr>
<td></td>
<td>NaturalTemplate_start.pptx</td>
</tr>
<tr>
<td>Chapter 14: Prepare for Delivery</td>
<td>CottageVideo_start.pptx</td>
</tr>
<tr>
<td></td>
<td>JournalingTimings_start.pptx</td>
</tr>
<tr>
<td></td>
<td>OrganizationCD_start.pptx</td>
</tr>
<tr>
<td></td>
<td>Procedures.docx</td>
</tr>
<tr>
<td></td>
<td>ServiceShows_start.pptx</td>
</tr>
<tr>
<td>Chapter 15: Customize PowerPoint</td>
<td>BuyersSeminar_start.pptx</td>
</tr>
<tr>
<td></td>
<td>ColorNew_start.pptx</td>
</tr>
</tbody>
</table>
Using the Practice Files

Your Companion eBook

The eBook edition of this book allows you to:

- Search the full text
- Print
- Copy and paste

To download your eBook, please see the instruction page at the back of this book.
Getting Help

Every effort has been made to ensure the accuracy of this book. If you do run into problems, please contact the sources listed in the following sections.

Getting Help with This Book

If your question or issue concerns the content of this book or its practice files, please first consult the book’s errata page, which can be accessed at:

http://go.microsoft.com/fwlink/?Linkid=192149

This page provides information about known errors and corrections to the book. If you do not find your answer on the errata page, send your question or comment to Microsoft Press Technical Support at:

mspinput@microsoft.com

Getting Help with PowerPoint 2010

If your question is about Microsoft PowerPoint 2010, and not about the content of this book, your first recourse is the PowerPoint Help system. This system is a combination of tools and files stored on your computer when you installed PowerPoint and, if your computer is connected to the Internet, information available from Office.com. You can find general or specific Help information in the following ways:

● To find out about an item on the screen, you can display a ScreenTip. For example, to display a ScreenTip for a button, point to the button without clicking it. The ScreenTip gives the button’s name, the associated keyboard shortcut if there is one, and unless you specify otherwise, a description of what the button does when you click it.

● In the PowerPoint program window, you can click the Microsoft PowerPoint Help button (a question mark in a blue circle) at the right end of the ribbon to display the PowerPoint Help window.

● After opening a dialog box, you can click the Help button (also a question mark) at the right end of the dialog box title bar to display the PowerPoint Help window. Sometimes, topics related to the functions of that dialog box are already identified in the window.
To practice getting help, you can work through the following exercise.

**SET UP** You don’t need any practice files to complete this exercise. Start PowerPoint, and then follow the steps.

1. At the right end of the ribbon, click the **Microsoft PowerPoint Help** button. The PowerPoint Help window opens.

Your Help window might look different from this one because the material on the Office.com Web site is constantly being updated.

**Tip** You can maximize the window or adjust its size by dragging the handle in the lower-right corner. You can change the size of the font by clicking the Change Font Size button on the toolbar.
2. Below the bulleted list under **Browse PowerPoint 2010 support**, click **see all**. The window changes to display a list of help topics.

3. In the list of topics, click **Activating PowerPoint**.

PowerPoint Help displays a list of topics related to activating Microsoft Office programs. You can click any topic to display the corresponding information.

4. On the toolbar, click the **Show Table of Contents** button, and then scroll down the pane that appears on the left.

Like the table of contents in a book, the Help table of contents is organized in sections. If you’re connected to the Internet, PowerPoint displays sections, topics, and training available from the Office Online Web site as well as those stored on your computer.

![PowerPoint Help screenshot](image)

*Clicking any section (represented by a book icon) displays that section’s topics (represented by help icons).*
5. In the **Table of Contents** pane, click a few sections and topics. Then click the **Back** and **Forward** buttons to move among the topics you have already viewed.

6. At the right end of the **Table of Contents** title bar, click the **Close** button.

7. At the top of the **PowerPoint Help** window, click the **Search** box, type **saving**, and then press the Enter key.

   The PowerPoint Help window displays topics related to the word you typed.

   ![PowerPoint Help Window](image)

   **Next and Back buttons appear to make it easier to search for the topic you want.**

   **Tip** If you enter a term in the Search box and then click the adjacent Search arrow, you specify the type of help you are looking for or where you want to look for it.
8. In the results list, click the **Recover earlier versions of a file in Office 2010** topic. The selected topic appears in the PowerPoint Help window.

9. Below the title at the top of the topic, click **Show All**.

   PowerPoint displays any hidden auxiliary information available in the topic and changes the Show All button to Hide All. You can jump to related information by clicking hyperlinks identified by blue text.

   **Tip** You can click the Print button on the toolbar to print a topic. Only the displayed information is printed.

**CLEAN UP** Click the Close button in the upper-right corner of the PowerPoint Help window.

---

**More Information**

If your question is about Microsoft PowerPoint 2010 or another Microsoft software product and you cannot find the answer in the product’s Help system, please search the appropriate product solution center or the Microsoft Knowledge Base at:

*support.microsoft.com*

In the United States, Microsoft software product support issues not covered by the Microsoft Knowledge Base are addressed by Microsoft Product Support Services. Location-specific software support options are available from:

*support.microsoft.com/gp/selfoverview/
Chapter at a Glance

- Edit pictures, page 196
- Customize diagrams, page 203
- Format charts, page 207
- Arrange graphics, page 214
8 Fine-Tune Visual Elements

In this chapter, you will learn how to
✔ Edit pictures.
✔ Customize diagrams.
✔ Format charts.
✔ Arrange graphics.

In Chapter 5, “Add Simple Visual Enhancements,” you were introduced to the primary ways you can use graphic elements to convey information or dress up your slides. You inserted pictures and clip art images, created a diagram, plotted data in a chart, drew shapes, and eased the transition from one slide to another with a graphic effect. These simple techniques might be all you need to enhance your presentations. But if you need to manipulate graphic elements to produce more dramatic effects, you can push the Microsoft Office PowerPoint 2010 capabilities further to get just the result you are looking for.

In this chapter, you’ll create a photo album and insert and manipulate photographs. Next, you’ll manipulate shapes to customize an organization chart. Then you’ll format a chart and save it as a template. Finally, you’ll use various techniques to arrange graphics.

**Practice Files** Before you can complete the exercises in this chapter, you need to copy the book’s practice files to your computer. The practice files you’ll use to complete the exercises in this chapter are in the Chapter08 practice file folder. A complete list of practice files is provided in “Using the Practice Files” at the beginning of this book.
Editing Pictures

From time to time in this book, we have alluded to the modern trend away from slides with bullet points and toward presentations that include more graphics. Successful presenters have learned that most people can’t listen to a presentation while they are reading slides. So these presenters make sure most of their slides display graphics that represent the point they are making, giving the audience something to look at while they focus on what is being said.

PowerPoint 2010 gives you the tools you need to create graphic-intensive rather than text-intensive presentations. When you want to display a dynamic array of pictures in a presentation, you can use a photo album template to do the initial layout and then customize the album by adding frames of different shapes, as well as captions.

Tip To integrate the slide layouts from a photo album template into a more traditional presentation, create the photo album and then import its slides into the other presentation by clicking Reuse Slides at the bottom of the New Slide gallery. For information about reusing slides, see “Adding Slides with Ready-Made Content” in Chapter 2, “Work with Slides.”

After you insert any picture into a presentation, you can modify it by using the buttons on the Format tab that is displayed on the ribbon only when the graphic is selected. For example, you can do the following:

- Remove the background by clicking the Remove Background button and then-designating either the areas you want to keep or those you want to remove.
- Sharpen or soften the picture, or change its brightness or contrast, by choosing the effect you want from the Corrections gallery.
- Enhance the picture’s color by making a selection from the Color gallery.
- Make one of the picture’s colors transparent by clicking Set Transparent Color at the bottom of the gallery and then selecting the color.
- Choose an effect, such as Pencil Sketch or Paint Strokes, from the Artistic Effects gallery.
- Apply effects such as shadows, reflections, and borders, or apply combinations of these effects by choosing a predefined style from the Picture Styles gallery.
- Add a border consisting of one or more solid or dashed lines of whatever width and color you choose.
- Rotate the picture to any angle, either by dragging the green rotating handle or by clicking the Rotate button and then choosing a rotating or flipping option.
- Crop away the parts of the picture that you don’t want to show on the slide. (The picture itself is not altered—parts of it are simply covered up.)
Minimize the presentation’s file size by clicking the Compress Pictures button and then choosing where or how the presentation will be viewed—for example, on the Web or printed—to determine the optimum resolution. You can also delete cropped areas of a picture to reduce file size.

In this exercise, you’ll create a photo album displaying pictures of native plants. You’ll crop, resize, remove the background, apply an artistic effect, and add captions. You’ll also reuse a slide from another photo album, and apply a theme.

**SET UP** You need the NativePlant1 through NativePlant8 photographs and the PhotoAlbumTitleSlide presentation located in your Chapter08 practice file folder to complete this exercise. Open a blank presentation, and then follow the steps.

1. On the **Insert** tab, in the **Images** group, click the **Photo Album** button. The Photo Album dialog box opens.

2. Under **Insert picture from**, click **File/Disk**. The Insert New Pictures dialog box opens.

3. Navigate to your **Chapter08** practice file folder, click **NativePlant1**, hold down the Ctrl key, and click **NativePlant3** through **NativePlant5**. Then click **Insert**. The Photo Album dialog box now has four graphics files listed in the Pictures In Album list.

   ![Photo Album dialog box](image)

   You can click each picture in turn to view it in the Preview box.
4. In the **Pictures in album** list, click **NativePlant4**, and then click the **Move Up** button to make it the second picture in the list.

5. Preview the pictures in turn, and then click the **Contrast** and **Brightness** buttons as necessary to give the four photographs a more even tone. You could also adjust the rotation of a picture, but in this case, that is not necessary.

6. In the **Album Layout** area, display the **Picture layout** list, and click **2 pictures**.

7. Display the **Frame shape** list, click **Rounded Rectangle**. Then click **Create**. PowerPoint creates a presentation called *Photo Album* that contains a title slide and two slides each containing two pictures.

8. **Save the presentation as** **My Photo Album**.

9. Display **Slide 2**, and click the photo on the left. Then on the **Format** contextual tab, in the **Size** group, click the **Crop** arrow. In the list, point to **Aspect Ratio**, and then under **Portrait**, click **2:3**.
PowerPoint crops away parts of the picture, leaving a centered “window” over the photo, sized to the proportions you specified.

10. Click the photo on the right, and then repeat the cropping process in step 9.

11. In turn, select each photo, and drag the upper-left and bottom-right corner handles until the photos occupy the majority of the space on the slide.

   **Tip** When sizing the photo on the right, release the mouse button when the dotted guide appears, letting you know that the photo is aligned with the photo on the left.

12. Display slide 3, and crop the photo on the left to **Square, 1:1**. Then point inside the crop window, and drag to the left until the cropping window is centered on the flower.

   PowerPoint maintains the size of the crop window but moves the photo under the window to the left.

   *The image of the flower is centered in the crop window.*
13. Click the photo on the right, and in the **Size** group, use the down arrow to reduce the height to 3". Then crop the photo to **Square, 1:1**, adjusting the crop window so that all of the flower is showing.

14. Enlarge and align the photos so that they occupy the entire width of the slide.

15. Click the left photo, and in the **Adjust** group, click the **Remove Background** button.

The Background Removal contextual tab appears, and PowerPoint marks the areas of the photo that will be removed.

![Remove Background](image)

The thumbnail on the Slides tab shows what the flower will look like after its background is removed.

16. Drag the handles on the frame surrounding the flower until the entire flower is visible within the frame. Then in the **Close** group, click the **Keep Changes** button.

17. Repeat steps 15 and 16 to remove the background of the photo on the right. Then click a blank area of the slide.

The background is removed from both flower photos.
The flowers stand out vividly against the plain slide background.

18. Click the photo on the left, and then on the Format tab, in the Adjust group, click the Artistic Effects button.

The Artistic Effects gallery appears.

You can choose from a wide variety of effects in this gallery.
19. Point to each thumbnail in turn to see a live preview of the photo with the effect applied. Then click the third thumbnail in the second row (Paint Brush).

20. Repeat steps 18 and 19 for the photo on the right.

The two photos now resemble paintings.

21. On the Insert tab, in the Images group, click the Photo Album arrow, and then click Edit Photo Album.

The Edit Photo Album dialog box opens. This dialog box is the same as the Photo Album dialog box. With it, you can make changes to an existing photo album.

22. In the dialog box, under Picture Options, select the Captions below ALL pictures check box, and then click Update.

23. Replace the file names below each photograph with the following captions:

NativePlant1 Achillea
NativePlant4 Hedysarum
NativePlant3 Gaillardia
NativePlant5 Oenothera

24. Click slide 1, and on the Home tab, in the Slides group, click the New Slide arrow, and at the bottom of the gallery, click Reuse Slides.

The Reuse Slides task pane opens.

25. In the Reuse Slides task pane, click Browse, and click Browse File. Then browse to your Chapter08 practice file folder, and double-click the PhotoAlbumTitleSlide presentation.

This presentation contains one slide that was based on a slide in the Contemporary Photo Album template available under the Sample Templates on the New page of the Backstage view.

26. In the Reuse Slides task pane, click Slide 1 to insert it after the title slide of the My Photo Album presentation. Then close the task pane.

27. Delete the blank title slide. Then on the Design tab, in the Themes group, display the Themes gallery, and select a theme that showcases the photos.

We chose the Trek theme.
Careful theme selection can pull an entire presentation together.

**CLEAN UP** Save the My Photo Album presentation, and then close it.

**Customizing Diagrams**

We’ve already told you how to use SmartArt to create a diagram, and we’ve shown you how to move and size it and apply simple formatting. But many diagrams involve different levels of information and benefit from more sophisticated formatting techniques. After you create a basic diagram, you can customize it at any time by clicking it and then using the commands on the Design and Format contextual tabs.

You can use the commands on the Design contextual tab to make changes such as the following:

- Add and change the hierarchy of shapes.

**Tip** You can remove a shape by selecting it and then pressing the Delete key. You can also rearrange shapes by dragging them.
Switch to a different layout of the same type or a different type.

**Tip** If some of the text in the original diagram doesn’t fit in the new layout, that text is not shown, but it is retained so that you don’t have to retype it if you change the layout again.

You can use the buttons on the Format contextual tab to customize individual shapes in the following ways:

- Change an individual shape—for example, change a square to a star to make it stand out.
- Apply a built-in Shape Style.
- Change the color, outline, or effect of a selected shape.

**Tip** If you customize a diagram and then decide you preferred the original version, you can revert to the original by clicking the Reset Graphic button in the Reset group on the Design contextual tab.

In this exercise, you’ll customize an organization chart by adding subordinate shapes. You’ll change the layout of the chart as a whole and then change the color, size, and text of individual shapes.

**SET UP** You need the ReorganizationMeeting_start presentation located in your Chapter08 practice file folder to complete this exercise. Open the Reorganization-Meeting_start presentation, and save it as ReorganizationMeeting. Then follow the steps.

1. Display slide 5, click the diagram to activate it, and then select the **Ryan Danner** shape for manipulation.
2. On the **Design** contextual tab, in the **Create Graphic** group, click the **Add Shape** arrow, and then click **Add Shape Below**.

   PowerPoint adds a shape to the organization chart.

3. Open the **Text** pane, click to the right of the bullet symbol, type **Jerry Orman**, and press Enter.

   PowerPoint adds a duplicate shape at the same level in the hierarchy.

   ![Organization Chart](image)

   *The colors of the shapes in the diagram reflect the theme color scheme*
Troubleshooting  Our instructions assume you are entering text in the Text pane. Typing and pressing Enter in a diagram shape enters a new paragraph in the same shape instead of creating a new shape.

4. Type **Nate Sun**.

5. In the **Text** pane, click to the right of **Erin Hagens**, press Enter, press Tab, and then type **Sarah Davis**.

   The new shape is a subordinate of Erin Hagens.

6. In the diagram, select the **Florian Stiller** shape for manipulation, click the **Add Shape** arrow in the **Create Graphic** group, and then click **Add Assistant**.

7. In the **Text** pane, click to the right of the arrow bullet symbol, and type **Andy Ruth**. Then close the **Text** pane.

8. In the diagram, select the **Nate Sun** shape for manipulation, and then in the **Create Graphic** group, click the **Promote** button.

   The selected shape moves up one level in the hierarchy.

9. Drag the handles around the frame of the diagram until it fills the available space on the slide.

10. On the **Design** contextual tab, display the **Layouts** gallery, and point to each thumbnail in turn to see a live preview of the various layout options for an organization chart. Then click the second thumbnail in the second row (**Hierarchy**).

   **Tip** Some of the new PowerPoint 2010 layouts allow you to insert pictures of people as well as their names.

11. Display the **SmartArt Styles** gallery, and after previewing the available styles, under **3-D**, click the last thumbnail in the first row (**Cartoon**).
12. Andy Ruth is an assistant, not a manager, so select his background shape, and on the Format tab, in the Shape Styles group, click the Shape Fill arrow. Then under Theme Colors in the palette that appears, click the tan box (Tan, Text 2).

13. Click the Florian Stiller shape (not the text), and then in the Shapes group, click the Larger button three times.

Troubleshooting Be sure to click the border of the shape. Otherwise, you will select the text for editing instead of the shape itself.

The background shape grows with the selected shape.

14. In the Shape Styles group, click the Shape Fill arrow, and then in the palette, click the third box in the fifth column (Gray-50%, Accent 1, Lighter 40%)

15. Display the WordArt Styles gallery, explore the options, and then click the third thumbnail in the first row (Fill – White, Drop Shadow).

The text in the shape is now a contrasting color.

16. Click outside the diagram frame.

You can now see the final result.

The number of employees that you want to include in an organization chart often determines which layout you choose.

CLEAN UP Save the ReorganizationMeeting presentation, and then close it.
Formatting Charts

You already know how to plot data in simple charts and how to edit that data in the associated Microsoft Excel worksheet. Often, you will need nothing more than these basic techniques to be able to convey your numeric data in a visual format. However, for those times when you need more than a basic chart, PowerPoint provides formatting capabilities that enable you to produce just the effect you want.

If you decide that the type of chart you selected doesn’t adequately depict the most important characteristics of your data, you can change the type at any time. There are 11 chart types, each with two-dimensional and three-dimensional variations, and you can customize each aspect of each variation. Common chart types include the following:

- **Column charts** Used to show how values change over time.
- **Bar charts** Used to show the values of several items at one point in time.
- **Line graphs** Used to show erratic changes in values over time.
- **Pie charts** Used to show how parts relate to the whole.

If you don’t want to spend a lot of time on a chart, you can apply the predefined combinations of formatting from the Chart Layouts and Chart Styles groups on the Design contextual tab to create sophisticated charts with a minimum of effort. However, if you want more control over the appearance of your chart, you can use the options on the Layout and Format contextual tabs. It is worth exploring these options so that you know how to do the following:

- Add shapes and pictures.
- Format individual elements such as titles, axes, data labels, and gridlines.
- Add trend lines, bars, and other lines.
- Customize the walls and floor or otherwise manipulate a three-dimensional chart.
- Customize the look of shapes.
- Add and format fancy text (WordArt).
- Arrange objects precisely.
- Precisely control the overall size of the chart.

You can double-click almost any chart object to change its attributes. For example, you can double-click an axis to display the Format Axis dialog box, where you can change the scale, tick marks, label position, line style, and other aspects of the axis. If you have trouble double-clicking some of the smaller chart elements, you can select the element you want to format from the Chart Elements list in the Current Selection group on the
Format tab, and then click the Format Selection button in the same group to display the Format dialog box for the selection.

If you make extensive modifications, you might want to save the customized chart as a template so that you can use it for plotting similar data in the future without having to repeat all the changes.

In this exercise, you’ll modify the appearance of a chart by changing its chart type and style. You’ll change the color of the plot area and the color of two data series. You’ll then hide gridlines and change the layout to display titles and a datasheet. After adding an annotation in a text box, you’ll save the chart as a template.

**SET UP** You need the LandscapingChart_start presentation located in your Chapter08 practice file folder to complete this exercise. Open the LandscapingChart_start presentation, and save it as LandscapingChart. Then follow the steps.

1. Display slide 14, and click the blank area above the chart legend to activate the chart without selecting any of its elements.

   **Troubleshooting** Be sure to click a blank area inside the chart frame. Clicking any of its elements will activate that element, not the chart as a whole.

   PowerPoint displays the Design, Layout, and Format contextual tabs.

2. On the **Design** contextual tab, in the **Type** group, click the **Change Chart Type** button.

   The Change Chart Type dialog box opens.

   Each chart category provides several different design options.
3. In the gallery on the right, under **Line**, double-click the fourth thumbnail (**Line with Markers**).

The column chart changes to a line chart, which depicts data by using colored lines instead of columns.

![Line chart example](chart_example.png)

*The temperature data plotted as a line chart.*

4. In the **Chart Styles** group, click the **More** button.

The Chart Styles gallery appears.

![Chart Styles gallery](styles_gallery.png)

*You can quickly switch to a different color scheme or data marker style.*

5. In the gallery, click the last thumbnail in the fourth row (**Style 32**).

The lines are now thicker, and the data markers are three-dimensional.
6. Move the pointer over the chart, and when a ScreenTip indicates you are pointing to the plot area, click to select it. The plot area is the area between the axes that contains the data markers.

7. On the **Format** contextual tab, in the **Shape Styles** group, click the **Shape Fill** arrow, and then in the list, click **More Fill Colors**.

The Colors dialog box opens.

![Colors dialog box](image)

*When none of the theme or standard colors meets your needs, you can pick a color in the Colors dialog box.*

8. On the **Standard** page, click the pale yellow below and to the left of the center, and then click **OK**.

The plot area is now a pale yellow shade to distinguish it from the rest of the chart.

**Tip** To change several aspects of the plot area, right-click the area and then click **Format Plot Area** to open the Format Plot Area dialog box. You can then change the fill, border, shadow, and 3-D format in one location.
9. At the top of the **Current Selection** group, click the **Chart Elements** arrow, and then in the list, click **Series “Maximum”**.

**Tip** If you have trouble selecting an element of the chart by clicking it, you can choose it from the **Chart Elements** list.

An outline appears around the data points of the selected series.

10. In the **Current Selection** group, click the **Format Selection** button.

The Format Data Series dialog box opens.

You can change several aspects of the selected data series in this dialog box.

11. In the left pane, click **Marker Fill**, and on the **Marker Fill** page, click **Solid Fill**. In the **Fill Color** area, click the **Color** button, and under **Standard Colors**, click the first box (**Dark Red**).

12. In the left pane, click **Line Color**. Then on the **Line Color** page, click **Solid line**, and change the color to the same dark red.
13. Repeat step 12 for the marker line color, and then click Close. The Maximum data series is now represented by the dark red color.

14. On the Layout tab, in the Axes group, click the Gridlines button, point to Primary Horizontal Gridlines, and then click None to remove the horizontal gridlines from the chart.

15. On the Design contextual tab, in the Chart Layouts group, click the More button. The Chart Layouts gallery appears.

You can quickly change the layout of the chart by selecting one of the predefined options.

16. In the gallery, click the first thumbnail in the second row (Layout 4). The legend now appears below the chart.

The plot area has expanded to occupy the area vacated by the legend.
Tip When you don’t have a lot of data, choosing a layout that includes a datasheet—a table with all the values plotted in the chart—can clarify without adding clutter. In this case, we have too much data to add a datasheet.

17. On the **Layout** contextual tab, in the **Insert** group, click the **Text Box** button.

18. Point below the chart title and above the July maximum temperature, and then drag diagonally down and to the right until the text box stretches as far as the December data.

19. Type **Hot periods can last several days**. Then select the text, and on the **Home** tab, in the **Font** group, change the size to **10** points and the color to **Red**.

20. Click a blank area within the chart frame to release the text box selection.

You can now see the results.

The annotated chart.

21. On the **Design** contextual tab, in the **Type** group, click the **Save As Template** button.

The Save Chart Template dialog box opens and displays the contents of your Charts folder, which is a subfolder of your Templates folder.

**Troubleshooting** If the **Charts** folder does not appear in the Address bar, navigate to the **AppData\Roaming\Microsoft\Templates\Charts** folder under your user profile.

22. With the **Charts** folder displayed in the **Address** bar, type **Temperature By Month** in the **File name** box, and then click **Save**.
23. In the **Type** group, click the **Change Chart Type** button, and then in the left pane of the **Change Chart Type** dialog box, click **Templates**. Then point to the icon under **My Templates** in the left pane. A ScreenTip identifies this template as the one you just created.

In the future, you can click the custom template to create a chart with the same layout and formatting.

**Tip** To delete a custom chart template, click **Manage Templates** in the lower-left corner of the **Change Chart Type** dialog box, and then when Windows Explorer opens with your **Charts** folder displayed, right-click the template and click **Delete**. Confirm that you want to delete the template by clicking **Yes**, close Windows Explorer, and then close the **Change Chart Type** dialog box.

24. Click **Cancel** to close the dialog box.

**CLEAN UP** If you don’t want to keep the chart template, delete it by following the directions in the preceding tip. Then save and close the **LandscapingChart** presentation.

**Arranging Graphics**

After inserting pictures or drawing shapes in the approximate locations you want them on a slide, you can align them and change their stacking order by clicking the buttons in the **Arrange** group on the **Format** contextual tab.
Clicking the Align button gives you access to commands for aligning individual or multiple graphics in several ways. For example, you can:

- Align graphics vertically by the left or right edges or centerline, or horizontally by the top or bottom edges or centerline.
- Distribute graphics evenly within their current space, either horizontally or vertically.
- Align graphics relative to the slide that contains them or to other selected objects.
- Align graphics relative to a position on the slide.
- Align graphics against gridlines and adjustable horizontal and vertical guides.

**Tip** If you added pictures to a slide by clicking the Picture button in the Images group on the Insert tab, you can group them and then align and position them as a group the same way you would group shapes. However, if you have added them by clicking the Insert Picture From File button in a content placeholder, you cannot group them. For information about grouping shapes, see “Drawing Shapes” in Chapter 5, “Add Simple Visual Enhancements.”

When graphics overlap each other, they are stacked. The stacking order is determined by the order in which you inserted the graphic. You can change the stacking order by selecting a graphic and then clicking the Bring Forward or Send Backward button to move the graphic to the top or bottom of the stack. To move the selected graphic forward in the stack one graphic at a time, click the Bring Forward arrow and then click Bring To Front in the list; to move it backward, click Send To Back in the Send Backward list.

**Tip** If you can’t select a graphic because it is covered by others in the stack, click the Selection Pane button to display the Selection And Visibility task pane, and then select the graphic you want from the Shapes On This Slide list.

In this exercise, you’ll align graphics in various ways, change their stacking order, and position them with the help of a grid and guidelines.

**SET UP** You need the GardenResidents_start presentation located in your Chapter08 practice file folder to complete this exercise. Open the GardenResidents_start presentation, and save it as GardenResidents. Then follow the steps.

1. On slide 1, select the three pictures.
2. On the Format contextual tab, in the Arrange group, click the Align button, and then in the list, click Distribute Vertically.
   The middle picture moves down so that it is the same distance below the left picture as it is above the right picture.
3. In the **Arrange** group, click the **Align** button, and then click **Align Center**.
   The pictures are now stacked on top of each other.

![Garden Residents](image)

*Sometimes graphics are completely hidden when they are stacked.*

4. Click away from the stack, and then click the top picture.

5. In the **Arrange** group, click the **Bring Forward** arrow, and then click **Bring to Front**.
   The top picture moves forward in the stack, obscuring the middle picture.

6. In the **Arrange** group, click the **Selection Pane** button.
   The Selection And Visibility task pane opens.
The top and middle pictures are designated as content placeholders because they were inserted into placeholders.

7. In the task pane, under **Shapes on this Slide**, click **Content Placeholder 10**. On the slide, the selection rectangle indicates that the middle picture is selected.

8. Close the **Selection and Visibility** task pane.

9. In the **Arrange** group, click the **Bring Forward** button. The middle picture moves forward in the stacking order.

10. In the **Arrange** group, click the **Align** button, and then click **View Gridlines**. A faint dotted grid appears on the slide.

11. Drag the selected cat picture to the right and down, so that its right and bottom borders align with the first gridlines from the right and bottom edges of the slide.

12. Drag the crow picture so that its right and bottom borders align with the second gridlines from the right and bottom edges of the slide.
13. Drag the frog picture so that its right and bottom borders align with the third gridline from the right and bottom edges of the slide. The pictures are now evenly stacked and spaced.

Gridlines make it easier to precisely align multiple graphics.

14. In the Arrange group, click the Align button, and then click Grid Settings. The Grid And Guides dialog box opens.

In this dialog box, you specify the size of the grid and other options.
15. In the **Grid settings** area, clear the **Display grid on screen** check box.

16. In the **Guide settings** area, select the **Display drawing guides on screen** check box, and then click **OK**.

   The grid disappears, and vertical and horizontal guides span the slide.

17. Point to the vertical guide away from any text or objects, and drag it to the left, releasing it when the accompanying ScreenTip reads **3.50**. Then drag the horizontal guide down until its ScreenTip reads **0.50**.

   **Troubleshooting** If you move an object on the slide instead of a guide, click the **Undo** button, and then point outside the margins of the slide to drag the guide.

   The ScreenTips show in inches how far each guide is from the 0 mark in the center of the slide. As you drag, numbers are skipped because the **Snap Objects To Grid** check box is selected in the Grid And Guides dialog box.

   **Tip** The **Snap Objects To Grid** option snaps guides and graphics to an invisible grid. You can turn off this option, and you can set the spacing of the grid in the Grid And Guides dialog box.

18. Point to the selected frog picture, and drag it to the left until its left and bottom borders align with the guides.

19. Select all the pictures. Then on the **Format** tab, in the **Arrange** group, click the **Align** button, and in the list, click **Distribute Horizontally**.

20. Repeat step 19 to distribute the pictures vertically.

21. In the **Arrange** group, click the **Align** button, click **Grid Settings**, and in the **Grid and Guides** dialog box, clear the **Display drawing guides on screen** check box. Then click **OK**.

22. Click the shape behind the pictures, and drag the green rotating handle clockwise until the shape stretches diagonally across the slide. Then drag the shape’s middle sizing handles until it is almost as wide as the pictures.

23. With the shape still selected, in the **Arrange** group, click the **Send Backward** arrow, and click **Send to Back**.

   The shape now sits behind the slide title as well as the pictures.

24. On the **View Shortcuts** toolbar in the lower-right corner of the program window, click the **Reading View** button.

   You can now see what the slide will look like during presentation delivery.
The finished slide in Reading view.

CLEAN UP  Save the GardenResidents presentation, and then close it.

Alt Text

Alt (alternate) text is a title and description associated with a graphic object that enables people with vision or other impairments to determine what the object is. You can add alt text to your objects to improve the accessibility of presentations that will be viewed on the screen without a presenter.

To associate alt text with an object:

1. Right-click the object, and click the corresponding Format command.
2. In the left pane of the Format dialog box, click Alt Text.
   The Alt Text page is displayed.
3. Enter a title and a description for the graphic object, and then click Close.
Key Points

- A growing trend among presenters is to create graphic-intensive rather than text-intensive presentations.

- If you want to move beyond simple diagrams, you need to know how to manipulate levels of text in shapes and how to format individual shapes as well as the diagram as a whole.

- With all the sophisticated chart formatting tools PowerPoint provides, it is important to remember that to be effective, charts need to be simple enough for people to grasp key trends at a glance.

- Knowing how to manipulate graphics on a slide will help you position, align, and stack them to get the effect you want.
Chapter at a Glance

Insert and play sounds, page 263

Insert and play videos, page 268
In this chapter, you will learn how to

✔ Insert and play sounds.
✔ Insert and play videos.

A Microsoft PowerPoint presentation is usually created to convey a lot of information in a short time. That information can be in the form of text, graphics, charts, and tables, but it might also consist of audio content. And sometimes the best way to ensure that your audience understands your message is to show a video. For example, if your company has developed a short advertising video, it makes more sense to include the video in a presentation about marketing plans than to try and describe it with bullet points or even pictures.

In this chapter, you’ll insert a sound clip and a sound file and make various adjustments to their settings. You’ll also insert two video files, edit one of them, and format them both.

Practice Files Before you can complete the exercises in this chapter, you need to copy the book’s practice files to your computer. The practice files you’ll use to complete the exercises in this chapter are in the Chapter11 practice file folder. A complete list of practice files is provided in “Using the Practice Files” at the beginning of this book.

Inserting and Playing Sounds

In “Adding Transitions” in Chapter 5, “Add Simple Visual Enhancements,” you added sound to a slide transition. You can also insert the following types of sounds:

- Audio files You can insert an audio file—for example, a speech or interview—by clicking the Audio button in the Media group on the Insert tab, and then selecting the file.
Sound clips You can insert a sound clip by clicking the Audio arrow in the Media group on the Insert tab, and then clicking Clip Art Audio to display the Clip Art task pane, where you can search for and select the sound you want. Clicking Find More At Office.com at the bottom of the task pane takes you to the Office.com Web site, where you can search for additional sounds.

See Also For information about using the Clip Art task pane, see “Inserting Pictures and Clip Art Images” in Chapter 5, “Add Simple Visual Enhancements.”

Recorded sounds You can record a sound or narration and attach it to a slide, all from within PowerPoint.

See Also For information about recording sounds, see the sidebar “Recording Presentations” in Chapter 14, “Prepare for Delivery.”

After you add a sound object, it appears on the slide represented by an icon. When the sound object is selected, a play bar appears below its icon with controls for playing the sound, and PowerPoint adds Format and Playback contextual tabs to the ribbon. You can change the icon as follows:

- Drag the object to locate it anywhere on the slide.
- Drag its sizing handles to make it larger or smaller.
- Use commands on the Format tab to change its appearance, in much the same way that you would format a picture.
- Click the Change Picture button to replace the default icon with a picture.

You can modify the sound itself on the Playback tab, as follows:

- Click the Trim Audio button in the Editing group to edit the sound so that only part of it plays.
- Specify Fade In and Fade Out settings to have the sound gradually increase and decrease in volume.
- Click the Volume button to adjust the volume to Low, Medium, or High, or to mute the sound.
- Specify whether the sound plays:
  - Automatically when the slide appears.
  - Only if you click its icon.
  - Throughout the presentation.
● Select the Hide During Show check box to make the sound object invisible while
the presentation is displayed in Reading view or Slide Show view.

● Select the Loop Until Stopped check box to have the sound play continuously until
you stop it.

● Select the Rewind After Playing check box to ensure that the sound starts from the
beginning each time it is played.

To play a sound, you must have a sound card and speakers installed. In Normal view, you
can test the sound associated with a slide by clicking its icon and then either clicking the
Play/Pause button on its play bar or clicking the Play button in the Preview group on the
Playback contextual tab.

In this exercise, you’ll insert a sound clip into a slide, adjust the position of the sound
object, change its picture, and make various other adjustments to its settings. Then you’ll
insert an audio file into another slide and make the file play continuously throughout a
presentation.

SET UP  You need the HealthyEcosystemsA_start and AGKCottage_start presentations,
the Bird picture, and the Amanda audio file located in your Chapter11 practice file
folder. Open the AGKCottage_start presentation, and save it as AGKCottage. Then
open the HealthyEcosystemsA_start presentation, and save it as HealthyEcosystemsA.
Be sure to turn on your computer’s speakers for this exercise. (If you do not have a
sound card and speakers, you can still follow the steps, but you won’t be able to hear
the sound.) With HealthyEcosystemsA displayed on your screen, follow the steps.

1. On the Insert tab, in the Media group, click the Audio arrow, and then click Clip
Art Audio.

   The Clip Art task pane opens, displaying thumbnails of common sound clips.

2. In the Search for box, type birds, and then click Go.

   The task pane now displays thumbnails of bird calls.

3. Click any thumbnail, click the arrow that appears, and then click Preview/
Properties.
The Preview/Properties dialog box for the sound clip you selected opens.

![Preview/Properties dialog box]

*When you display this dialog box, PowerPoint downloads and plays the sound clip.*

**Troubleshooting** The sound clips available from Office.com change frequently, so don’t worry if you don’t see the Birds At Dawn clip in your Clip Art task pane. Just use a different clip.

4. Click **Close** to close the dialog box, and continue previewing sound clips.

5. When you are ready, double-click a sound clip that you think is appropriate for the slide, and then close the **Clip Art** task pane.

We chose Birds Singing. A small speaker icon representing the sound object appears in the middle of the slide, along with a play bar. It is hard to see the icon because it is on top of the picture.

6. Drag the sound object to the upper-left corner of the slide.

The play bar moves with the sound object.
The handles around the sound object indicate that you can resize it, just like any other object.

7. On the play bar, click the **Play/Pause** button to hear the sound.

The sound plays. Now let’s change the picture associated with the object.

8. With the sound object selected, on the **Format** contextual tab, in the **Adjust** group, click the **Change Picture** button. Then in the **Insert Picture** dialog box, double-click the **Bird** picture in your **Chapter11** practice file folder.

9. On the **Playback** contextual tab, in the **Audio Options** group, display the **Start** list, and click **Automatically**. Then select the **Loop until Stopped** check box.

10. On the **View Shortcuts** toolbar, click the **Reading View** button.

PowerPoint plays the sound clip.

11. Move the pointer over the bird representing the sound object, and when the play bar appears, click the **Play/Pause** button. Then press the Esc key to return to Normal view.

12. Display the **AGKCottage** presentation, and view it in Reading view, pressing Esc after a few slides.

This presentation would benefit from a “sound track.”
13. With slide 1 displayed, on the Insert tab, in the Media group, click the Audio button. Then in the Insert Audio dialog box, double-click the Amanda file in your Chapter11 practice file folder.

14. On the Playback tab, in the Audio Options group, display the Start list, and then click Play across slides. Then select the Hide During Show and Loop until Stopped check boxes.

15. Switch to Reading view.

The audio file plays while PowerPoint moves from slide to slide.

16. Press Esc to stop the presentation and return to Normal view.

CLEAN UP  Save and close the HealthyEcosystemsA and AGKCottage presentations.

Inserting and Playing Videos

In keeping with the trend toward more visual presentations, PowerPoint 2010 has new video capabilities that broaden the range of videos you can use and what you can do with them. You can insert the following types of movies in slides:

- **Video files**  You can insert a digital video that has been saved as a file in one of two ways: If a slide’s layout includes a content placeholder, you can click the Insert Movie Clip button in the placeholder. You can also click the Video button in the Media group on the Insert tab. Either way, the Insert Video dialog box opens so that you can select the file.

- **Videos from Web sites**  For information, see the sidebar “Inserting Videos from Web Sites” later in this chapter.

- **Clip art videos**  Clip art videos are animated graphics, rather than real videos. Clicking the Video arrow in the Media group on the Insert tab and then clicking Clip Art Video displays the Clip Art task pane, where you can search for and select the clip you want. Clicking Find More At Office.com at the bottom of the task pane takes you to the Microsoft Office Online Web site, where you can search for additional clips. When you insert a clip art video, it appears as a picture on the slide, and PowerPoint adds a Format contextual tab to the ribbon so that you can adjust the way the picture looks. The clip moves only when you display the slide in Reading view or Slide Show view, and you cannot adjust its action.

See Also  For information about using the Clip Art task pane, see “Inserting Pictures and Clip Art Images” in Chapter 5, “Add Simple Visual Enhancements.”
Both video files and videos from Web sites appear on the slide as video objects that you can size and move to meet your needs. When you select a video object, PowerPoint adds Format and Playback contextual tabs to the ribbon. You can change the way the object appears on the slide as follows:

- Drag the object to locate it anywhere on the slide.
- Drag its sizing handles to make it larger or smaller.
- Use commands on the Format tab to change its appearance, in much the same way that you would format a picture.

You can modify the video itself on the Playback tab, as follows:

- Click the Trim Video button in the Editing group to edit the video so that only part of it plays.
  
  **Tip** You can find out the total playing time of a video by displaying the Trim Video dialog box.

- Specify Fade In and Fade Out settings to have the video gradually appear and disappear.

- Click the Volume button to adjust the volume to Low, Medium, or High, or to mute the sound.

- Specify whether the video plays:
  - Automatically when the slide appears.
  - Only if you click the object.

- Select the Play Full Screen check box to have the video occupy the entire slide space while playing.

- Select the Hide While Not Playing check box to make the video object invisible while the presentation is displayed in Reading view or Slide Show view.

- Select the Loop Until Stopped check box to have the video play continuously until you stop it.

- Select the Rewind After Playing check box to ensure that the video starts from the beginning each time it is played.

In Normal view, you can test the video associated with a slide by clicking the video object and then either clicking the Play/Pause button on its play bar or clicking the Play button in the Preview group on the Playback contextual tab.

In this exercise, you’ll insert two videos into a slide, adjust the size of their objects, format the objects, and make various other adjustments to their settings.
SET UP You need the HealthyEcosystemsB_start presentation and the Butterfly and Wildlife video files located in your Chapter11 practice file folder. Open the HealthyEcosystemsB_start presentation, and save it as HealthyEcosystemsB. Then follow the steps.

1. In the Slide pane, in the left content placeholder, click the Insert Media Clip button.

2. In the Insert Video dialog box, double-click the Butterfly file in your Chapter11 practice file folder.

The video is inserted as an object in the content placeholder with a play bar below it.

3. On the play bar, click the Play/Pause button to watch the video.

The play bar is similar to the one for a sound object.
4. Repeat steps 1 through 3 to insert the **Wildlife** video in the right content placeholder, and then play the video.

Let’s trim this video so that it shows only the animal that looks like a big ground squirrel.

5. With the **Wildlife** video selected, on the **Playback** contextual tab, in the **Editing** group, click the **Trim Video** button.

The Trim Video dialog box opens.

You can advance through the video frame by frame to identify the start and end times.

6. Drag the green start marker to the right until it sits at about the **00:17.020** mark. Then click the **Next Frame** button, pausing after each click, until the first ground squirrel frame comes into view at the **00:17.288** mark.
7. Drag the red stop marker to the left until it sits at about the **00:20.900** mark. Then click the **Next Frame** button, pausing after each click, until the last ground squirrel frame comes into view at the **00:20.799** mark.

8. Click **OK**. Then play the trimmed video.

9. Click the **Butterfly** video object, and on the **Format** tab, in the **Size** group, click the **Height** arrow until the object is **3** inches tall.
   
   The width of the object increases proportionally. Let’s make the **Wildlife** object the same size.

10. Click the **Wildlife** object, and in the **Size** group, change its **Height** to **3**.

    Because this video object is now too wide, we need to crop it from the left.

11. Right-click the object, and click **Format Video**. Then in the **Format Video** dialog box, click the **Crop** tab.

    The settings on this page take the trial-and-error out of any cropping task.

    ![Format Video dialog box](image)

    *The Crop page of the Format Video dialog box.*

    In the **Crop position** area, change the **Width** setting to **4″**. Then click **Close**.
13. Drag the objects until they are evenly spaced on the slide, using the Align commands in the Arrange group as necessary to line them up.

14. With both objects selected, click the More button in the Video Styles group. The Video Styles gallery appears.

You can select a frame for the video from this gallery.

Tip In addition to formatting a video with a ready-made video style, you can choose from the Video Shape, Video Border, and Video Effects galleries to create your own combinations. Just be careful not to overdo it.

15. Under Intense, click the fifth thumbnail in the first row (Reflected Bevel, Black). Then click away from the objects.
You can now see the results.

*The two video objects have rounded frames and reflections.*

16. Click the **Butterfly** object, and on the **Playback** contextual tab, in the **Video Options** group, click the **Volume** button, and then click **Mute**.

17. In the **Video Options** group, display the **Start** list, and click **Automatically**. Then select the **Loop until Stopped** check box.

18. Click the **Wildlife** object, set **Volume** to **Mute**, leave **Start** set to **On Click**, and select the **Loop until Stopped** check box.

19. Switch to Reading view, and preview and pause the **Butterfly** video. Then preview and pause the **Wildlife** video.

20. Press Esc twice to return to Normal view.

**CLEAN UP** Close the HealthyEcosystemsB presentation without saving your changes.
Inserting Videos from Web Sites

If you find a video on a public Web site that you want to use to illustrate a point in a presentation, you might be able to insert a link to the video into a slide. The format of the video must be supported by Windows Media Player, and the owner of the video must have made it available to the public. You can tell which videos are publicly available by right-clicking the video and looking for a Copy Embed HTML command. If you do not see this command, the owner has secured the video, and you cannot play it from anywhere but the site on which it is published.

To insert a link to a video on a Web site:

1. Display the video, right-click it, and then click Copy Embed HTML.
2. Display the slide into which you want to insert the video.
3. On the Insert tab, in the Media group, click the Video arrow, and then click Video From Web Site.

The Insert Video From Web Site dialog box opens.
4. In the dialog box, click in the text box, and then press Ctrl+V (the keyboard shortcut for the Paste command).

The copied embed code is inserted at the cursor.

To view the video, switch to Reading view or Slide Show view, and then click the Play/Pause button. PowerPoint then uses the embed code to locate and play the video. Provided the video remains available in its original location, and provided you have an active Internet connection, you will be able to access and play the video from the slide at any time.
Key Points

- Audio and video clips can convey information or simply add interest.
- Use the sounds that come with PowerPoint, or supply your own audio files.
- After you insert an audio or video object, you can change the way it looks and the way it plays to suit your needs.
Index

A
A3 Paper slide size, 152
A4 Paper slide size, 152
accent colors, 92
accepting/rejecting revisions, 300
accessibility, 169
Action button
defined, 369
uses for, 242–243
action buttons
drawing, 244
overview of, 242
Action Settings dialog box, 243
Add Animation button, 253
Add Shape button, 204
adding annotations to graphics, 59
adding pictures, 117
adding slides, 37, 324
adding text boxes to slides, 117
adding text to diagrams, 123
add-ins
defined, 358
installing, 358
settings for, 356
sources for, 358
adjusting gridlines, 218
adjusting shapes, 136
adjustment handles, 369
advanced options, 355
albums, photo
captioning pictures in, 202
creating, 306
defined, 372
overview of, 196
Align button, 215
Align Text Left button, 104
Align Text Right button, 104
aligning graphics, 215
aligning slide elements, 30
aligning text, 104
alt text, adding to graphics, 220
alternative words, 78
angle of text, changing, 60
animated graphics, 268
animating bullet points, 252, 256
animating pictures, 253
animating titles, 250
animation
adding sounds, 256, 259
applying multiple, 253
copying, 253
defined, 369
effect order, changing, 255
previewing, 252
sounds, 256, 259
speed and duration, changing, 255
start time, changing, 258
turning off, 156
Animation gallery, 250
Animation Painter, 250, 261
Animation Painter button, 253
Animation pane, 259
Animation Pane button, 259
Animations tab, 14
annotating graphics, 59
Apply To All button, 147, 337
applying different themes, 91
Arrange All button, 33
arranging open presentations, 33
arranging slides, 52
arrows on buttons, 7
Artistic Effects button, 201
artistic effects for pictures, 196, 201
Artistic Effects gallery, 196, 201
assigning passwords, 292
attributes
applying, 105
defined, 369
Audio button, 265, 268
audio files, inserting, 263
AutoCorrect, 72, 75
customizing, 72
defined, 369
limitations of, 73
for math equations, 234
modifying, 75
options, setting, 352
synonyms, 82
AutoFit
changing default settings, 72
reducing text size with, 77
AutoFit Options button, 72, 76
automatic slide shows, starting, 157
automatic update of pictures, 115
automating tasks with macros, 371
AutoRecover options, 353
autosave time interval, changing, 19
Autoshapes, adjusting, 369

B
B4 (ISO) Paper slide size, 152
B5 (ISO) Paper slide size, 152
Back button, 23
Back button (Help), xxviii
backgrounds
applying, 99
changing, 99
colors for, 92
defined, 369
formatting placeholder, 102
of pictures, removing, 196, 200
of slides, changing, 95
styles, changing, 11, 96
Background Styles button, 11, 96
Background Styles gallery, 96
Backstage view, 5
Help page, 16
Info page, 15, 168, 280
New page, 16, 18, 306, 327
Print page, 16, 159
Recent page, 15
Save & Send page, 16, 280, 289, 326, 341
banded rows in tables, 186
Banner slide size, 152
banners, 154
bar charts, 207
Basic animations, 254
bitmaps, 121
black and white
creating slides in, 30
previewing in, 158
printing in, 159
Black And White button, 158
black screen, changing default, 33, 176
blank presentations, opening, 18
blocking content, 357
BMP, 121
Bold button, 350
bold text, 105
book features and conventions, xix
borders
adding to text boxes, 61, 64
picture, 196
borders around tables, 187
breaks
defined, 371
inserting, 105
Bring Forward button, 216-217
Broadcast Slide Show button, 282
Broadcast Slide Show dialog box, 282
broadcasting presentations, 282
Browse dialog box, 42
building slides with animation, 255
bullet points. See also subpoints
adjusting indents, 313
animating, 252, 256
changing into diagrams, 128
changing spacing, 317
collapsing on Outline tab, 68
converting to regular text, 108, 320
defined, 369
pictures as characters for, 315
Bullets And Numbering dialog box, 315
Bullets button, 103, 108, 315, 320
Bullets gallery, 103, 108
buttons
adding to Quick Access Toolbar, 366
arrows on, 7
changing default action of, 7
ScreenTips, displaying, 350
viewing information on. See ScreenTips
capitalization
  changing, 105
defined, 369
captioning photo album pictures, 202
captions, 369
capturing screenshots, 235
case
  changing, 105
defined, 369
categories. See galleries
category axes in charts, 129
category axis (x-axis), 374
cell addresses, 129, 369
cells
  addresses, 129, 369
centering text in, 184
  combining, 182, 184
defined, 369
dividing, 182
drawing, 182
  formatting, 185
  merging, 182, 184
  moving between, 182
  shading, 187
  splitting, 182, 373
Center button, 104
centering text, 184
Change Case button, 105
Change Chart Type button, 208
Change Chart Type dialog box, 208
Change Colors button, 126
Change Colors gallery, 126
Change Picture button, 267
changes, undoing, 68
changing backgrounds, 99
changing default number of undo actions, 69
changing direction of text in text boxes, 60
changing magnification of slides, 35
changing order of slides, 52
changing slide magnification, 30
changing slide sizes, 154
changing user name initials, 297
character formatting
  attributes, 369
clearing, 105
defined, 369
  for individual characters, 105
  overview of, 104
character spacing, changing, 105
Character Spacing list, 105
characters, nonstandard
  inserting, 228, 230
  overview of, 227
chart area, 369
Chart button, 128
Chart Elements list, 207, 211
chart elements, selecting, 207, 211
Chart Layouts gallery, 212
charts. See also data markers; data points;
  data series; tick-marks
  adding text boxes, 213
  adding to slides, 128
  associated Excel worksheets, 128
category axes, 129
changing styles, 209
changing type, 208
copying Excel data, 132
data markers, 129
data points, 129
data series, 129
defined, 369
editing data, 133
entering data, 130
excluding data from, 132
formatting, 207
gridlines, changing, 212
hiding data, 132
layout, changing, 212
legends, 129, 212, 371
saving as templates, 208, 213
selecting for automatic updates, 134
series axes, 129
sizing, 133
slides, adding to, 128
switching rows/columns, 135
text boxes, adding to, 213
tick-mark labels, 129
value axes, 129
Chart Styles gallery, 209
chart types, 208
Check Accessibility tool, 169
Check Compatibility tool, 169
checkerboard effect, 145. See also transitions
Choose A SmartArt Graphic dialog box, 122
Choose File To Merge With Current Presentation
dialog box, 300
Clear All Formatting button, 105, 107
clearing character character formatting, 105
clip art
  adding to slides, 114
  defined, 369
  free from Microsoft Office Online Web site, 114
  searching for, 118
  videos, inserting, 268
Clip Art button, 114, 118
Clip Art task pane, 114, 118, 264-265, 268
Clipboard
  defined, 369
  overview of, 67, 371
  viewing, 71
clips, sound
  changing picture, 267
  hiding, 265
  modifying, 264
  moving, 266
  overview of, 264
Close button, xxviii, 4, 27
Close button (Excel), 133
Close button (Windows Taskbar), 27
Close Master View button, 311
Close Task Pane button, 44
closing Notes pane, 33
closing Overview pane, 9
closing PowerPoint, 4
collaborating, 279-280
Collapse Section button, 51
collapsing bullet points on Outline tab, 68
collating when printing, 159
collections of pictures (photo albums)
  captioning pictures in, 202
  creating, 306
  defined, 372
  overview of, 196
Color gallery, 196
color gradients, 95, 369
color of pen, 175
color of text, 105
color of user interface, 351
color palettes, 92
color printing, 159
color schemes, 92
  additional colors, 110
  applying to selected slide, 92
  chosen by professional designers, 92
  creating, 306
  creating custom, 92
  creating unique, 110
  defined, 369
  viewing, 92
color slides, comparing with black and white, 30
color wheel, 307
colors. See also color gradients
  assigning to presentation elements, 307
  transparent, in pictures, 196
Colors button, 93, 306
Colors dialog box, 110, 210, 307
Colors gallery, 92, 306
column charts, 207
column headers, 369
columns
  defined, 369
  deleting, 182
  headers in, 369
  inserting, 182
combining cells
  defined, 371
  overview of, 182, 184
commands. See also ribbon
  displaying on tabs, 5
  grouped on tabs, 5
  hiding, 7
  location of, 5
  managing presentations in Backstage view, 5
comments
  adding, 296
  defined, 369
  deleting, 296, 299
  editing, 296, 298
  hiding, 296, 299
  moving between, 296, 298
  printing, 159
Compare button, 300
comparing versions, 299
compatibility with earlier versions of PowerPoint, 24, 169
Compatibility mode, 24
compressing pictures/media, 197, 343-44
Compress Pictures button, 197, 344
Compress Pictures dialog box, 344
Confirm Password dialog box, 294
connecting shapes, 144
connection points
  defined, 369
  creating, 144
connectors, 370
content placeholders
  adding pictures without, 117
  overview of, 114
content templates, 18
contextual tabs, 370
continuous slide shows, 156
Convert button, 24
converting bulleted lists to diagrams, 128
converting bullet points to regular text, 108, 320
converting presentations to .pptx format, 24
Copy button
  in Excel, 132
  in PowerPoint, 67
copying animations, 253
copying chart data from Excel, 132
copying formatting, 306
copying shape formatting, 137, 144
copying shapes, 137
copying slides from other presentations, 41
copying text
  keyboard shortcut for, 68
  procedure for, 67, 70
copying text boxes, 60
copyright symbol. See symbols
copyrights, 114
correcting mistakes automatically, 72
correcting pictures, 196
Corrections gallery, 196
crash, repairing files after, 25
Create New Theme Colors dialog box, 92, 307
Create New Theme Fonts dialog box, 92, 308
creating backgrounds, 99
creating tables, 181
crediting pictures, 117
Crop button, 198
cropping pictures, 196, 198
cropping videos, 272
currency symbols. See symbols
cursor, 370
custom color schemes, 92, 306
Custom DPI Setting dialog box, xvii
custom font schemes, 92
custom font sets, 306
custom layouts, 318
custom presentation elements, 305
Custom Shows dialog box, 332
Custom Slide Show button, 332
custom slide shows
  defined, 370
  creating, 332
  editing, 334
custom slide sizes, 152
custom templates, 326
Custom XML Data check box, 172
CUSTOM.DIC dictionary, 78, 81
Customize Quick Access Toolbar button, 366
Customize Ribbon page, 359
Customize Status Bar menu, 7
customizing AutoCorrect, 72
customizing Quick Access Toolbar, 5, 366
customizing ribbon, 361
Cut button
cutting text
  keyboard shortcut for, 68
  procedure for, 67, 70
cycle diagrams
  defined, 370
  overview of, 120
D
data, entering into chart worksheets, 130
data markers in charts, 129, 370
data points in charts, 129, 370
data series in charts, 129, 370
dates in footers, 153
Decrease Font Size button, 104
Decrease List Level button, 58
default formatting of shapes, 137
default last slide, changing from black slide, 33
default theme, 306
Define Custom Show dialog box, 332
Delete button (comments), 296, 299
Delete button (tables), 182
deleting
  columns, 182
  comments, 296, 299
  information, 168, 342
  items from Clipboard, 71
  local formatting, 308
  passwords, 295
  picture backgrounds, 196, 200
  rows, 182
  sections, 52
  shapes, 203
  slides, 37
  text, 69
delivering presentations
  overview of, 178, 331
  Presenter view, 161
demoting text, 58
deselecting text boxes, 61
Design tab, 11
design templates
  custom, 326
  defined, 370
  overview of, 18
destination files, 188, 370-71. See also linked objects
diagrams. See also cycle diagrams; hierarchy diagrams; process diagrams; relationship diagrams
  adding shapes, 204
  adding text, 123
  adding to notes pages, 164
  adding to slides, 121-122
  changing colors, 126
  changing layout, 204, 205
  creating from bulleted list, 128
  cycle, 120
  defined, 370
  hierarchy, 120
  moving, 122, 125
  notes pages, adding to, 164
  opening Text pane, 124
  predefined sets of formatting, 121
  process, 120
  relationship, 121
  restoring original, 204
  shapes, adding, 204
  slides, adding to 121-122
  sizing, 122, 125
  text, adding, 123
  viewing layouts, 125
dialog box launcher, 7, 12, 370
dialog boxes
  displaying, 7
  help with, xxv
  launching, 7, 12, 370
  moving, 85
dictionaries
  in English version of PowerPoint, 78
  supplemental, 78, 81
digital signatures, 292
digital videos. See also video objects
cropping, 272
inserting, 268
looping, 274
playing, 270
rewinding, 269
saving, 343
sound for, 269, 274
starting automatically, 274
testing, 269
trimming, 269, 271
from Web sites, 275
dimming after animation, 256
direction of text, changing in text boxes, 60
directory paths, 372
disabilities, checking for accessibility, 269
display action buttons, 242
display effects
  adding animations, 147
  adding to presentations, 145, 149
  associating sounds with, 148
  defined, 374
  dynamic content, 146
  exciting, 145
  presentations, adding to, 145, 149
  removing animation, 147
  sounds for, 148
  subtle, 145
  timing, 149
  viewing, 148
display settings different from book, xviii
displaying gridlines, 217
displaying guides, 218
displaying outlines, 9
displaying slides full screen, 175
displaying thumbnails, 9
distributing pictures, 215
dividing cells, 182
dividing presentations into sections, 46
Document Inspector
  overview of, 168, 342
  running, 171
Document Panel, 168
downloading practice files, xx1
dpi settings, xvii
drag-and-drop editing, 67
dragging objects, 370
Draw Table button, 182
drawing action buttons, 244
drawing cells, 182
drawing objects, 372
drawing shapes
  adding text, 137, 140
  adding to diagrams, 204
  adjusting, 136
  attaching hyperlinks to, 237
  changing effect, 102
  changing outline, 101
  connecting, 144, 370
  copying, 137, 139
copying formatting, 137, 144
defined, 373
deleting, 203
diagrams, adding to, 204
drawing, 136
duplicating, 137, 140
enlarging, 206
filling with color, 100
flipping, 139
formatting, 100, 137, 204
grouping, 142
hyperlinks, attaching, 237
moving, 137
rotating, 136, 139, 219
setting default formatting, 137
sizing, 136, 140
text, adding, 137, 140
drawing tables, 182
duplicating shapes, 137, 140
duplicating slides, 41, 44
dynamic effects
adding sounds, 256, 259
applying multiple, 253
copying, 253
defined, 369
effect order, changing, 255
previewing, 252
sounds, 256, 259
speed and duration, changing, 255
start time, changing, 258
turning off, 156

E
Edit Comment button, 296, 298
Edit Data button, 133
Edit Shape button, 142
editing chart data, 133
editing comments, 296, 298
editing custom slide shows, 334
editing headers/footers before printing, 159
editing sounds, 264
editing text, 70. See also drag-and-drop editing
effect of shapes, changing, 102
Effect Options button, 147, 255, 258
effects. See also animation; transitions
artistic, for pictures, 196, 201
schemes, 93
Effects button, 93
effects schemes, 93
efficiency, improving, 5
e-mail messages, initiating with hyperlinks, 237
e-mailing presentations, 289
embedded fonts, 353
embedded objects
defined, 370
overview of, 188
embedding Excel worksheets, 188
embedding fonts, 342, 353
Emphasis animations, 254
encrypted passwords, 292, 294
encrypting
defined, 370
passwords, 292, 294
enhanced handouts, 167
enlarging shapes, 206
entering text, 56
on Outline tab, 56
in Slide pane, 56
in tables, 183
in text boxes, 60
Entrance animations, 250
Equation button, 229, 231
Equation gallery, 229
equations
AutoCorrect feature, 234
building, 229
formatting, 233
inserting, 229, 232
saving, 233
Eraser button, 182
erasing slide markup, 177
errors
deleting using Backspace, 56
reducing, 78
Excel worksheets
associated with charts, 128
embedding, 188
exercise format, xviii
existing presentations, using as templates, 18
Exit animations, 254
exiting PowerPoint, 4
expanding ribbon, 7, 366
Expand Section button, 52
Expand The Ribbon button, 7
exporting presentations as outlines, 46
extensions, file name, 22
F

fancy text, 224
faxing presentations, 290
features and conventions of book, xix
file formats
  overview of, 370
  saving as, 354
  saving presentations in, 283
  setting default, 353
file name extensions
  defined, 370
  overview of, 22
  .pptx, 24
file size, minimizing, 197
File tab, 15
files
  audio, inserting, 263
  opening, 25
  opening with hyperlinks, 237
  types of, 22, 24, 3700
Fill Color button, 192
finalizing presentations, 169
Find button, 84
Find dialog box, 84
Find text, 86
finding fonts, 86
finding text, 84
First Line Indent marker
  defined, 370
  setting, 312
Fit Slide To Current Window button, 8, 35
fitting slides to page when printing, 159
flipping shapes, 139
flying onto slide effect, 146. See also transitions
collection paths, 372
followed hyperlink colors, 92
Font box, 104
Font Color button, 92, 105, 106, 110
Font Size box, 104
fonts
  changing, 104
  defined, 370
  embedding, 342, 353
  replacing, 84, 86
font schemes
  applying, 94
  creating custom, 92
font sets, creating, 306
Fonts button, 94, 308, 315
Fonts gallery, 92, 94, 306
footers
  adding to notes pages, 165
  adding to slides, 155
  editing before printing, 159
  excluding from title slide, 155
  notes pages, adding to, 165
  overview of, 153, 370
  removing from masters, 317
  slides, adding to, 155
foreign languages, specifying, 354
Format Background dialog box, 12, 97
Format Data Series dialog box, 211
Format Painter button, 137, 144, 306, 314, 323
format, Rich Text (RTF)
  defined, 373
  importing outlines, 40
  saving presentations as, 46
Format Selection button, 208, 211
Format Shape dialog box, 60
Format Video dialog box, 272
formats, setting default, 353
formatting
  copying, 306
  hiding in Slide Sorter view, 32
  removing local, 308
  retaining for reused slides, 44
formatting bullet points on masters, 315
formatting cells, 185
formatting charts, 207
formatting effects for text, 110
formatting individual characters, 105
formatting on masters, 314-315
formatting options, 8
formatting placeholder background, 102
formatting shapes
  copying formatting, 137, 144
  procedure for, 137, 204
formatting tables, 185
formatting text on masters, 314
formulas, mathematical
  AutoCorrect feature, 234
  building, 229
  formatting, 233
  inserting, 229, 232
  saving, 233
Forward button (Help), xxviii
Fraction button, 232
Fraction gallery, 232

fractions
- AutoCorrect feature, 234
- building, 229
- formatting, 233
- inserting, 229, 232
- saving, 233

French dictionary, 78

frequent commands, adding to Quick Access Toolbar, 5

From Beginning button, 32

G

galleries
- closing, 13
- defined, 370
- formatting thumbnails, 8
- opening, 12
- sizing, 187

General Options dialog box, 293

Get A Digital ID dialog box, 292

GIF, 121

Gradient gallery, 101

graphics
- adding alt text, 220
- adding to notes pages, 162
- adding to slides, 114-115
- albums of. See photo albums
- alignment options, 215
- animating, 253
- annotating, 59
- applying artistic effects, 196 201
- artistic effects, 196, 201
- attaching hyperlinks to, 237
- automatic updating, 115
- background, removing, 196, 200
- captions, 369
- compressing, 343
- correcting, 196
- crediting, 117
- cropping, 196, 198
- defined, 372
- distributing, 215
- grouping, 215
- linking for automatic updating, 115
- moving, 116
- notes pages, adding to, 162
- overview of, 113-114
- removing background, 196, 200
- rotating, 196
- selecting hidden, 216
- shades. See grayscale
- sizing, 116-117
- slides, adding to, 114-115
- SmartArt, 120-121, 163, 373
- stacking order, 215, 216
- transparent color, 196

graphics formats, 121

Graphics Interchange Format, 121

greyscale
- defined, 371
- previewing before printing in, 158
- printing in, 159

Grayscale button, 158

Grid And Guidelines dialog box, 218

gridlines
- adjusting, 218
- in charts, changing, 212
- displaying, 30, 217

Gridlines button, 212

Group button, 142

grouping pictures, 215

grouping shapes, 142, 371
groups, tab, 371
guides. displaying, 218

H

handles
- adjustment, 369
- around shapes, 136
- defined, 371
- rotating, 373
- sizing, 373
- using, 116

Handout Master view, 371

handout masters, 161, 310, 371

handouts
- creating in Word, 167
- enhanced, 167
- printing, 158

Hanging Indent marker
- defined, 371
- setting, 312, 317

Header And Footer dialog box, 153, 154, 159, 165

Header & Footer button, 154, 165
headers
  adding to notes pages, 165
  editing before printing, 159
Help button, xxv, xxvi
Help page of Backstage view, 16
Help window, xxvi
  navigating, xxviii
  printing from, xxix
  searching, xxviii
  table of contents, displaying, xxvii
  topics, displaying, xxvii
Hide Slide button, 334
hiding
  comments, 296, 299
  formatting, in Slide Sorter view, 32
  graphics, 216
  Mini Toolbar, 351
  ribbon, 366
  ribbon commands, 7
  slides, 332, 334-335
  sound objects, 265
  video objects, 269
hierarchy diagrams
  defined, 371
  overview of, 120
highlighting during presentations, 175
highlighting objects, 373
Home tab, 6, 10
HTML tags, 374
Hyperlink button, 238
hyperlink colors, 92
Hyperlink To Slide dialog box, 243
hyperlinks
  adding to slide masters, 241
  defined, 371
  on every slide, 241
  overview of, 237-238
  specifying ScreenTips for, 240
Hypertext Markup Language (HTML), 371
defined, 371
tags, 374
images
  adding alt text, 220
  adding to notes pages, 162
  adding to slides, 114-115
  albums of. See photo albums
  alignment options, 215
  animating, 253
  annotating, 59
  applying artistic effects, 196 201
  artistic effects, 196, 201
  attaching hyperlinks to, 237
  automatic updating, 115
  background, removing, 196, 200
  captions, 369
  compressing, 343
  correcting, 196
  crediting, 117
  cropping, 196, 198
  defined, 372
  distributing, 215
  grouping, 215
  linking for automatic updating, 115
  moving, 116
  notes pages, adding to, 162
  overview of, 113-114
  removing background, 196, 200
  rotating, 196
  selecting hidden, 216
  shades. See grayscale
  sizing, 116-117
  slides, adding to, 114-115
  SmartArt, 120-121, 163, 373
  stacking order, 215, 216
  transparent color, 196
importing outlines, 40
Increase Font Size button, 104, 107
Increase List Level button, 58
increasing/decreasing space between letters, 105
indent marker, First Line
  defined, 370
  setting, 312
indent marker, Left
  defined, 371
  setting, 312
indent markers, 371
infinity symbol, 234. See also equations; symbols
Info page of Backstage view, 15, 168, 280
information, removing from presentations, 168, 172, 342
Information Rights Management, 295
initials, setting, 351
Insert Above button, 184
Insert Chart button, 128, 131
Insert Chart dialog box, 131
Insert Hyperlink dialog box, 238
Insert Layout button, 318, 319
Insert Media Clip button, 270
Insert Movie Clip button, 268
Insert New Pictures dialog box, 197
Insert Object dialog box, 189
Insert Outline dialog box, 41
Insert Picture dialog box, 114, 115, 117, 267
Insert Picture From File button, 114, 115
Insert Placeholder arrow, 319
Insert SmartArt Graphic button, 121, 122
Insert tab, 11
Insert Table button, 181, 182
Insert Table dialog box, 182
Insert Video dialog box, 268, 270
Insert Video From Web Site dialog box, 275
inserting
   columns, 182
   line breaks, 105
   rows, 182, 184
   rows at bottom of table, 182
   slides, into other documents, 114
installing add-ins, 358
international languages, specifying, 354
Internet Explorer, 374
Internet links
   adding to slide masters, 241
   defined, 371
   on every slide, 241
   overview of, 237-238
   specifying ScreenTips for, 240
Italic button, 106, 321
italicizing text, 105

J
Joint Photographic Experts Group, 121
JPEG, 121
jumping to slides/Web sites with hyperlinks, 237
jumping to slides with action buttons, 242
Justify button, 104

K
Keep Changes button, 200
keyboard shortcuts
   for copying text, 68
   for cutting text, 68
   defined, 371
   displaying, 11
   for editing text, 68
   for pasting text, 68
   for redoing editing, 68
   for undoing editing, 68
kiosk mode, 371
Knowledge Base, xxix

L
Language button, 79
Language dialog box, 79
languages, specifying additional, 354
Larger button, 206
launcher, 7, 12, 370
Layout button, 40
layout, chart, 212
layout, diagram, 204-205
Layout gallery, 38
layout, slide
   applying, 40
   changing existing slides, 38
   custom, 318
   diagram, 125
   master, 310
   naming, 323
Ledger Paper slide size, 152
Left Indent marker
   defined, 371
   setting, 312
legacy commands, 360
legacy compatibility, 24
legends, chart, 129, 212, 371
letter-by-letter animation, 256, 259
Letter Paper slide animation, 256
libraries, slide
   defined, 373
   overview of, 45
line breaks
   defined, 371
   inserting, 105
line graphs, 207
line spacing, 104, 108
Line Spacing button, 104, 108
Linear button, 233
lining up slide elements, 30
linked objects
   defined, 371
   linking, 188
links
   adding to slide masters, 241
   defined, 371
   on every slide, 241
   overview of, 237-238
   specifying ScreenTips for, 240
list boxes. See galleries
list items. See bullet points; subpoints
Microsoft Office, 372
overview of, 105, 369
Microsoft Office Clipboard
defined, 369
overview of, 67, 371
viewing, 71
Microsoft Office Online Web site
downloading presentations from, 18
free clip art images, 114
Microsoft PowerPoint Help button, xxv, xxvi
Microsoft PowerPoint Viewer
defined, 372
displaying, 340
Microsoft Product Support Services, xxix
Microsoft SharePoint
collaborating on presentations, 280
file location, setting default, 353
Microsoft Word handouts, 167
Mini Translator, 83
Minimize button, 4, 235
Minimize The Ribbon button, 7
minimizing presentations, 4
minimizing ribbon, 7
mistakes, correcting automatically, 72
Mobile App, 281
Moderate animations, 254
modifying AutoCorrect, 75
monitors, multiple, 174
More button, 13, 90
Motion Animation, 254
Move Up button, 362
moving
between cells, 182
between comments, 298
diagrams, 122, 125
dialog boxes, 85
pictures, 116
Quick Access Toolbar, 366
shapes, 137
slides, 50
sound objects, 266
tables, 184
text, 67
text boxes, 60, 63
multi-line text boxes, 59
muting video sound, 274

M
macros, 371
magnification
changing, 34
changing globally, xvi
changing for slides, 30, 35
marking presentations as final, 169
marking slides during presentations, 175
masters
bullet point formatting, 315
defined, 371
formatting bullet points on, 315
formatting text on, 314
handouts, 161, 310
notes, 161, 310, 372
placeholders, 310
primary, 310
removing footers, 317
slide, 310
text formatting, 314
viewing, 313
Math AutoCorrect, 234
mathematical symbols. See equations; symbols
Maximize button, 4, 34
media, compressing, 343
Meeting Properties dialog box, 171
menus
Customize Status Bar, 7
Start, 4
Merge Cells button, 182, 184
merging cells
defined, 371
overview of, 182, 184
merging presentations, 299
Microsoft Knowledge Base, xxix
Microsoft Office Button, 5. See also Backstage view
Microsoft Office Calculator, 234
Microsoft Office Online Web site
downloading presentations from, 18
free clip art images, 114
Microsoft PowerPoint Help button, xxv, xxvi
Microsoft PowerPoint Viewer
defined, 372
displaying, 340
Microsoft Product Support Services, xxix
Microsoft SharePoint
collaborating on presentations, 280
file location, setting default, 353
Microsoft Word handouts, 167
Mini Translator, 83
Minimize button, 4, 235
Minimize The Ribbon button, 7
minimizing presentations, 4
minimizing ribbon, 7
mistakes, correcting automatically, 72
Mobile App, 281
Moderate animations, 254
modifying AutoCorrect, 75
monitors, multiple, 174
More button, 13, 90
Motion Animation, 254
Move Up button, 362
moving
between cells, 182
between comments, 298
diagrams, 122, 125
dialog boxes, 85
pictures, 116
Quick Access Toolbar, 366
shapes, 137
slides, 50
sound objects, 266
tables, 184
text, 67
text boxes, 60, 63
multi-line text boxes, 59
muting video sound, 274

M
macros, 371
magnification
changing, 34
changing globally, xvi
changing for slides, 30, 35
marking presentations as final, 169
marking slides during presentations, 175
masters
bullet point formatting, 315
defined, 371
formatting bullet points on, 315
formatting text on, 314
handouts, 161, 310
notes, 161, 310, 372
placeholders, 310
primary, 310
removing footers, 317
slide, 310
text formatting, 314
viewing, 313
Math AutoCorrect, 234
mathematical symbols. See equations; symbols
Maximize button, 4, 34
media, compressing, 343
Meeting Properties dialog box, 171
menus
Customize Status Bar, 7
Start, 4
Merge Cells button, 182, 184
merging cells
defined, 371
overview of, 182, 184
merging presentations, 299
Microsoft Knowledge Base, xxix
Microsoft Office Button, 5. See also Backstage view
Microsoft Office Clipboard
defined, 369
overview of, 67, 371
viewing, 71
Microsoft Office Online Web site
downloading presentations from, 18
free clip art images, 114
Microsoft PowerPoint Help button, xxv, xxvi
Microsoft PowerPoint Viewer
defined, 372
displaying, 340
Microsoft Product Support Services, xxix
Microsoft SharePoint
collaborating on presentations, 280
file location, setting default, 353
Microsoft Word handouts, 167
Mini Translator, 83
Minimize button, 4, 235
Minimize The Ribbon button, 7
minimizing presentations, 4
minimizing ribbon, 7
mistakes, correcting automatically, 72
Mobile App, 281
Moderate animations, 254
modifying AutoCorrect, 75
monitors, multiple, 174
More button, 13, 90
Motion Animation, 254
Move Up button, 362
moving
between cells, 182
between comments, 298
diagrams, 122, 125
dialog boxes, 85
pictures, 116
Quick Access Toolbar, 366
shapes, 137
slides, 50
sound objects, 266
tables, 184
text, 67
text boxes, 60, 63
multi-line text boxes, 59
muting video sound, 274
N
naming layouts, 323
narration, turning off, 156
navigating with action buttons, 242
navigation action buttons, 242
Navigation button, 176
navigation toolbar, 175-176
New Comment button, 297
New Folder button, 19, 22
New page of Backstage view, 16, 18, 306, 327
New Presentation dialog box, 328
New Presentation window, 18
New Slide button, 38, 39, 41, 202, 324
New Slide gallery
    overview of, 39, 324
    selecting layouts from, 37
Next button, 254
Next button (comments), 296, 298
Next button (Reading view), 335
Next button (revisions), 302
Next Frame button, 271
Next Page button (Print Page), 159
Next Slide button, 26, 163
non–color scheme colors, 110
nonstandard color schemes, 110
Normal button, 9, 32, 48, 164
Normal view, 9, 10, 28
    creating slide sections in, 50
    defined, 372
    panes, 9
    sizing panes, 30
notes master
    defined, 372
    overview of, 161, 310
Notes Master view, 372
Notes Page button, 161, 162
notes pages
    adding diagrams, 164
    adding headers/footers, 165
    adding pictures, 162
    printing, 158, 165
Notes Page view
    defined, 372
    overview of, 29, 161
Notes pane
    closing, 33
    defined, 372
    displaying, 9

notes, speaker. See also comments
    adding to slides, 9, 161, 163
    creating, 29
    diagrams, adding, 164
    entering for slides, 9
    headers/footers, adding, 165
    in Notes pane, 9, 33
    preparing, 167
    printing, 158, 165
Numbering button, 103
numeric data, displaying visually, 128

O
Object button, 189
object commands, 370
objects, attaching hyperlinks to, 237
objects, embedded
    defined, 370
    overview of, 188
objects, linked
    defined, 371
    linking, 188
Office.com. See Microsoft Office Online Web site
Office menu. See Backstage view
On-screen Show slide size, 152
Open dialog box, 25, 26
open presentations
    arranging, 33
    switching among, 33
opening
    diagram Text pane, 124
    files with hyperlinks, 237
    Overview pane, 9
    PowerPoint, 4, 10
    presentations, 25
Options dialog box, 287
outline of shapes, changing, 101
Outline tab, 9, 31, 58, 372
outlines
    exporting presentations as, 46
    importing into slides, 41
    opening as presentations, 42
    printing, 158
    viewing, 31
Overhead slide size, 152
Overview pane
    defined, 372
    opening/closing, 9
pictures
adding alt text, 220
adding to notes pages, 162
adding to slides, 114-115
albums of. See photo albums
animating, 253
annotating, 59
applying artistic effects, 196 201
artistic effects, 196, 201
attaching hyperlinks to, 237
automatic updating, 115
background, removing, 196, 200
captions, 369
compressing, 343
correcting, 196
crediting, 117
cropping, 196, 198
defined, 372
distributing, 215
grouping, 215
linking for automatic updating, 115
moving, 116
notes pages, adding to, 162
overview of, 113-114
removing background, 196, 200
rotating, 196
selecting hidden, 216
shades. See grayscale
sizing, 116-117
slides, adding to, 114-115
SmartArt, 120-121, 163, 373
stacking order, 215, 216
transparent color, 196
pie charts, 207
pixels, 372
Placeholder gallery, 319
placeholders, 59
adjusting size to fit text, 105
changing AutoFit settings, 72
changing effect, 102
changing outline, 101
content, 114
defined, 372
filling with color, 100
formatting, 100
formatting background, 102
inserting in new layouts, 319
masters, 310
selecting all text in, 107
size/position of, 59
PowerPoint 2010, upgrading from, xii
PowerPoint 2010 Mobile App, 281
PowerPoint 2010 Web App, 281
PowerPoint Help button, xxv, xxvi
PowerPoint Help window, xxvi
PowerPoint icon, 4
PowerPoint Options dialog box, 6, 17, 73, 350, 352, 355, 359
PowerPoint presentations. See also design templates
adding transitions, 145, 149
adjusting display of content, 8
blank, 18
broadcasting, 282
closing, 26, 28
collaborating on, 279
comparing, 299
compatibility with earlier versions, 24
controlling audience view, 174
creating, 18, 21
custom elements, 305
default view, 9
delivering, 178, 331 delivering in Presenter view, 161
design of, changing. See masters
displaying properties, 169
dividing into sections, 46
downloading from Office.com, 18
embedding fonts in, 342
exporting as outlines, 46
faxing, 290
highlighting during, 175
jumping to with hyperlinks, 237
looping continuously, 156
managing, 5, 15
marking as final, 169
marking slides during, 175
merging, 299
minimizing file size, 197
moving within, 26, 27
opening, 25, 26
packaging, 340
pausing, 335
preparing for delivery, 157
previewing, 161
printing, 158, 161
rearrange, 50
recently worked on, displaying, 15
recording, 338
rehearsing, 337
removing ending black screen, 176
removing information from, 168, 172, 342
restricting access, 295
reviewing, 279
saving, 19, 24
saving, as earlier version, 24
saving, as PowerPoint Shows, 285
saving, as.rtf file, 46
saving, as videos, 343
saving, as XPS files, 285
saving, in different file formats, 283
sending link via e-mail, 289
sending via e-mail, 289
sharing, 16, 279
starting, 18
themes. See themes
viewing more than one open, 33
voice comments, 339
for Web page banners, 154
PowerPoint Show format, 284, 285
PowerPoint slides
adding, 37, 40, 324
adding using Outline tab, 58
applying color scheme to selected, 92
applying layouts, 40
building with animation, 255
changing existing layout, 38
changing order within presentations, 52
changing zoom percentage, 30
charts, adding, 128
clip art images, adding, 114
comments, adding, 296
comparing color with black and white, 30
copying from other presentations, 41
custom shows. See also custom slide shows
date/time, adding, 155
deleting, 37, 40
diagrams, adding, 121-122
displaying full screen, 175
displaying preview, 160
displaying together as thumbnails, 31
dividing into sections, 50
duplicating, 41, 44
embedded objects in, 188
entering notes for, 9
fitting to window size, 35
footer, adding, 155
hiding, 332, 334
highlighting during presentations, 178
importing outlines, 40, 41
jumping to with action buttons, 242
jumping to with hyperlinks, 237
libraries, 45, 373
linked objects in, 188
masters. See slide masters
moving, 50
notes, adding, 161, 163
pictures, adding, 115
previewing, 160
printing, 16, 158
rearranging, 52
rearranging in Slide Sorter view, 51
renaming sections, 48
reusing, 44, 202
saving as pictures, 114
showing subsets, 332
sizing, 152, 154
in slide libraries, 45, 373
slide number, adding, 155
text, adding, 56
timing. See slide timing
titles. See titles
WordArt text, adding, 154
PowerPoint Viewer
defined, 372
displaying, 340
ppi settings, xvii
.ppsx format, 284
.ppt format
overview of, 283, 354
saving presentations in, 24
.pptx format
converting presentations to, 24
overview of, 283
practice files
downloading, xxi
list of, xxi
preparing presentations for delivery, 157
presentation format, 353
presentation history, 15
presentation properties
changing, 168
controlling, 15
displaying, 15, 169
editing, 172
removing from presentations, 172
presentations. See also design templates
adding transitions, 145, 149
adjusting display of content, 8
blank, 18
broadcasting, 282
closing, 26, 28
collaborating on, 279
comparing, 299
compatibility with earlier versions, 24
controlling audience view, 174
creating, 18, 21
custom elements, 305
default view, 9
delivering, 178, 331
delivering in Presenter view, 161
design of, changing. See masters
displaying properties, 169
dividing into sections, 46
downloading from Office.com, 18
embedding fonts in, 342
exporting as outlines, 46
faxing, 290
highlighting during, 175
jumping to with hyperlinks, 237
looping continuously, 156
managing, 5, 15
marking as final, 169
marking slides during, 175
merging, 299
minimizing file size, 197
moving within, 26, 27
opening, 25, 26
packaging, 340
pausing, 335
preparing for delivery, 157
previewing, 161
printing, 158, 161
rearrange, 50
recently worked on, displaying, 15
recording, 338
rehearsing, 337
removing ending black screen, 176
removing information from, 168, 172, 342
restricting access, 295
reviewing, 279
saving, 19, 24
saving, as earlier version, 24
saving, as PowerPoint Shows, 285
saving, as .rtf file, 46
saving, as videos, 343
saving, as .xps files, 285
saving, in different file formats, 283
sending link via e-mail, 289
sending via e-mail, 289
sharing, 16, 279
starting, 18
themes. See themes
viewing more than one open, 33
voice comments, 339
for Web page banners, 154
Presenter view, 161, 174
Preview button, 252
previewing
animation, 252
cut or copied items before pasting, 68
presentations, 157, 161
Preview/Properties dialog box, 266
previews, displaying live in Slide pane, 12
Previous button (Reading view), 335
Previous button (comments), 296, 298
Previous Slide button, 26
primary master, 310
Print button, 158, 161
printing, 16
frames around slides, 159
Help topics, xxix
overview of, 16
presentations, 157-158, 161
speaker notes, 165

Print page of Backstage view, 16, 159
print quality, changing, 159
process diagrams, 120, 372
professionally designed color schemes, 92
program window
minimizing, 4
resizing, xv
programs, starting, 242
promoting text, 58
properties
changing, 168
controlling, 15
defined, 372
displaying, 15, 169
editing, 172
removing from presentations, 172
Properties dialog box, 168
Publish As PDF or XPS dialog box, 285
Pushpin button, 7

Q
Quick Access Toolbar
for active presentation, 366
adding buttons to, 365-366
adding separator to, 367
buttons, adding, 365-366
customizing, 5, 366
defined, 373
moving, 5
moving below ribbon, 366
resetting, 368
separator, adding, 367
Quick Print button, 367

R
Reading view
defined, 373
overview of, 9, 28
Reading View button, 148, 156, 219, 267, 336
read-only
defined, 373
overview of, 169
rearranging presentations, 50
rearranging slides, 52
Recent page of Backstage view, 15
recent presentations, displaying, 15
recording presentations, 338
recording sounds, 264
Record Slide Show button, 339
Record Slide Show dialog box, 339
Redo button, 5, 68, 70
redoing editing, 68
reducing text size using AutoFit, 77
reflections, picture, 196
Rehearse Timings button, 337
rehearsing slide timings, 337
relationship diagrams
  defined, 373
  inserting, 121
Remove Background button, 196, 200
removing
  columns, 182
  comments, 296, 299
  information, 168, 342
  items from Clipboard, 71
  local formatting, 308
  passwords, 295
  picture backgrounds, 196, 200
  rows, 182
  sections, 52
  shapes, 203
  slides, 37
  text, 69
Rename button, 323
Rename dialog box, 363
Rename Section dialog box, 48
renaming
  ribbon tabs, 363
  sections, 48
Replace button, 84, 86
Replace dialog box, 84
Replace Font dialog box, 84, 86
replacing
  fonts, 84
  text, 67, 84, 86
Research button, 83
Research task pane, 78, 81, 83
researching information, 83
Reset Graphic button, 204
resizing
  charts, 133
  diagrams, 122, 125
  galleries, 187
  panes, 30, 35
  pictures, 116-117
  placeholders, 59, 105
program window, xv
ribbon, xv
shapes, 136, 140
slides, 152, 154
text boxes, 60
resolution, screen, xv
Restore Down button, 4
restoring diagrams, 204
retaining formatting for reused slides, 44
Reuse Slides task pane, 42, 202
reused slides, retaining formatting, 44
reusing slides, 41, 44, 202
reversing changes, 68
reviewing presentations, 279
Review tab, 14
revisions, accepting/rejecting, 300
Revisions task pane, 300
rewinding videos, 269
ribbon
  button appearance, xiv
  changing appearance, 5
  commands, adding to, 362
  commands no longer on, 360
  commands on, xiii
  customizing, 359-361
  decreasing width of, xiv
  defined, 373
  dynamic nature of, xiv
  expanding, 7, 366
  groups, displaying all commands in, xiv
  groups in, 6
  groups in, removing, 360, 361
  hidden groups, displaying, xiv
  hiding, 366
  hiding commands, 7
  legacy commands, 360
  location of, 5
  minimizing, 7
  moving commands on, 362
  overview, 7
  overview of, xiii
  resetting customizations, 364
  tabs, removing, 360, 361
  tabs, showing command groupings, 5
  width, changing, xv
Rich Text Format (RTF)
  defined, 373
  importing outlines, 40
  saving presentations as, 46
ripple effect, 145. See also transitions
Rotate button, 139, 196
rotating effect, 146. See also transitions
rotating handle, 373
rotating
pictures, 196
shapes, 136, 139, 219
text, 60, 63
row headings, 373
rows
banded, 186
deleting, 182
inserting, 182, 184
inserting at bottom of table, 182
RTF (Rich Text Format)
defined, 373
importing outlines, 40
saving presentations as, 46
Ruler check box, 116
rulers, displaying, 30
running PowerPoint, 4, 10

S
Save As dialog box, 18, 46, 283, 285
Save As Template button, 213
Save button, 5, 18, 21, 57
Save Chart Template dialog box, 213
Save Current Theme dialog box, 309
Save & Send page of Backstage view, 16, 280,
289, 326, 341
saving charts as templates, 208, 213
saving PowerPoint Shows, 285
saving presentations
in different file formats, 283
as earlier version, 24
as PowerPoint Shows, 285
as .rtf files, 46
in new folder, 19
process for, 19, 24
to SkyDrive, 281
as videos, 343
as XPS files, 285
saving templates, 326
saving themes, 309
saving XPS files, 285
scaling slides when printing, 159
screen magnification
changing, 34
changing globally, xvi
changing for slides, 30, 35
screen resolution, xv
Screenshot button, 235
Screenshot gallery, 235
screenshots, capturing, 235
ScreenTips, xxv
customizing display of, 6
defined, 373
feature descriptions, hiding in, 351
language, specifying, 354
specifying for hyperlinks, 240
viewing, 6
searching for clip art images, 118
searching Help, xxviii
Section button, 47, 49
sections
creating in Slide Sorter view, 48
deleting, 52
dividing presentations into, 46, 50
rerearranging, 52
Select button, 107
Select button (tables), 187
selecting
chart elements, 207, 211
defined, 373
hidden graphics, 216
placeholder text, 107
text, 67
Selection And Visibility task pane, 215, 216, 322
Selection Pane button, 215, 216, 322
Send Backward button, 219, 313
series axis (y-axis), 129, 374
Set Hyperlink ScreenTip dialog box, 240
Set Up Show dialog box, 153, 156, 174
Set Up Slide Show button, 156
setting up automatic slide show, 157
setting up presentations, 157
SGML. See Hypertext Markup Language (HTML)
Shading button, 187
shading cells, 187
shadow effect, 105, 196
Shape Effects button, 102
Shape Fill button, 100, 206, 210
Shape Outline button, 101, 322
Shape Styles, 204
shapes
  adding text, 137, 140
  adding to diagrams, 204
  adjusting, 136
  attaching hyperlinks to, 237
  changing effect, 102
  changing outline, 101
  connecting, 144, 370
  copying, 137, 139
  copying formatting, 137, 144
  defined, 373
  deleting, 203
  diagrams, adding to, 204
  drawing, 136
  duplicating, 137, 140
  enlarging, 206
  filling with color, 100
  flipping, 139
  formatting, 100, 137, 204
  grouping, 142
  hyperlinks, attaching, 237
  moving, 137
  rotating, 136, 139, 219
  setting default formatting, 137
  sizing, 136, 140
  text, adding, 137, 140
Shapes button, 136, 137, 244
Shapes gallery, 137
SharePoint
  collaborating on presentations, 280
  file location, setting default, 353
sharing presentations, 16, 279
shortcuts, keyboard
  for copying text, 68
  for cutting text, 68
  defined, 371
  displaying, 11
  for editing text, 68
  for pasting text, 68
  for redoing editing, 68
  for undoing editing, 68
Show Markup button, 296, 299
Show Table of Contents button, xxvii
shrinking text to fit text box, 61
shutter effect, 145. See also transitions
side-by-side presentations, 33
sigma symbol. See equations; symbols
Sign dialog box, 292
Signature Setup dialog box, 292
signatures, digital, 292
single-line text boxes, 59
sizing
  charts, 133
  diagrams, 122, 125
  galleries, 187
  panes, 30, 35
  pictures, 116-117
  placeholders, 59, 105
  program window, xv
  ribbon, xv
  shapes, 136, 140
  slides, 152, 154
  text boxes, 60
sizing handle, 373
SkyDrive, 281
slide backgrounds, 95
slide layouts, selecting, 37
slide libraries
  defined, 373
  overview of, 45
slide magnification, 35. See also magnification
slide markup
  erasing, 177
  printing, 159
Slide Master button, 310, 313
Slide Master view
  defined, 373
  working in, 310, 313
slide masters
  adding hyperlinks to, 241
  overview of, 310, 313
  defined, 373
slide numbers in footers, 153
Slide Orientation button, 154
Slide pane, 9
  adding text in, 56
  defined, 373
  displaying live previews in, 12
Slide Show button, 175, 176
Slide Show tab, 14
Slide Show view, 9, 28, 32, 151
  defined, 373
  starting automatic slide shows in, 157
slide shows
  custom, 332
  looping continuously, 156
  starting automatic, 157
  starting from beginning, 32
  stopping before reaching the end, 32
Slide Sorter button, 31, 47, 148, 336
Slide Sorter view, 9, 28, 31, 148
creating sections in, 48
defined, 373
hiding formatting in, 32
rearranging slides in, 51
slide timings
applying to all slides, 336
defined, 373
overview of, 335
rehearsing, 337
slides
adding, 37, 40, 324
adding using Outline tab, 58
applying color scheme to selected, 92
applying layouts, 40
building with animation, 255
changing existing layout, 38
changing order within presentations, 52
changing zoom percentage, 30
charts, adding, 128
clip art images, adding, 114
comments, adding, 296
comparing color with black and white, 30
copying from other presentations, 41
custom shows. See also custom slide shows
date/time, adding, 155
deleting, 37, 40
diagrams, adding, 121-122
displaying full screen, 175
displaying preview, 160
displaying together as thumbnails, 31
dividing into sections, 50
duplicating, 41, 44
embedded objects in, 188
entering notes for, 9
fitting to window size, 35
footer, adding, 155
hiding, 332, 334
highlighting during presentations, 178
importing outlines, 40, 41
jumping to with action buttons, 242
jumping to with hyperlinks, 237
libraries, 45, 373
linked objects in, 188
masters. See slide masters
moving, 50
notes, adding, 161, 163
pictures, adding, 115
previewing, 160
printing, 16, 158
rearranging, 52
rearranging in Slide Sorter view, 51
renaming sections, 48
reusing, 44, 202
saving as pictures, 114
showing subsets, 332
sizing, 152, 154
in slide libraries, 45, 373
slide number, adding, 155
text, adding, 56
timing. See slide timing
titles. See titles
WordArt text, adding, 154
Slides tab
defined, 373
working in, 9, 50
SmartArt button, 121, 163
SmartArt graphics. See also diagrams
defined, 373
inserting, 121, 163
overview of, 120
SmartArt Styles gallery, 126
smart tag. See Action button
snapping to grid, 219
sound clips
changing picture, 267
hiding, 265
modifying, 264
moving, 266
overview of, 264
sound icon, 264
sound objects
changing picture, 267
hiding, 265
modifying, 264
moving, 266
overview of, 264
sound tracks, 267
sounds
adding to animation, 256, 259
adjusting volume, 264
associating with transitions, 148
editing, 264
icon, 264
looping, 267
modifying, 264
pausing, 267
playing, 267
playing across slides, 268
playing continuously, 265
playing with action buttons, 242
recording, 264
starting over, 265
testing, 265
source documents
defined, 373
overview of, 188
source file, 188
source programs
defined, 373
overview of, 188
spacing
between letters, 105
of bullet points, changing, 317
Spanish dictionary, 78
speaker notes
adding to slides, 161, 163
creating, 29
diagrams, adding, 164
entering for slides, 9
headers/footers, adding, 165
preparing, 167
printing, 158, 165
special characters. See symbols
Spelling button, 78, 80
spelling checker, 78, 81
Split Cells button, 182
splitting cells
by drawing borders, 182
defined, 373
procedure for, 182
splitter bar, 30
stacked objects, 373
stacking order of graphics, 215, 216
changing, 313
overview of, 215-216
stacking text, 60
Standard Generalized Markup Language (SGML).
See Hypertext Markup Language (HTML)
Start menu, 4
starting
PowerPoint, 4, 10
programs, 242
slide shows, 32
videos, 274
status bar
Customize Status Bar menu, 7
customizing, 7
default items on, 8
defined, 373
strikethrough effect, 105
style of charts, 209
subpoints, 373
subtitles, animating, 250
Subtle animations, 254
supplemental dictionaries, 78, 81
Switch Row/Column button, 135
Switch Windows button, 33, 91
switching among open presentations, 33, 91
switching among PowerPoint views, 30
switching rows/columns in charts, 135
Symbol button, 228, 230
Symbol dialog box, 228, 230
symbols
inserting, 228, 230
overview of, 227
synonyms, 78, 81-82. See also Thesaurus
Table button, 181
table cells
addresses, 129, 369
centering text in, 184
combining, 182, 184
defined, 369
dividing, 182
drawing, 182
formatting, 185
merging, 182, 184
moving between, 182
shading, 187
splitting, 182, 373
table of contents (Help), xxvii
Table Styles gallery, 186
tables
attaching hyperlinks to, 237
banded rows, 186
borders around, 187
creating, 181
defined, 374
drawing, 182
entering text into, 183
vs. Excel worksheets, 188
formatting, 185
moving, 184
overview of, 181
structure of, 181
styles, 185-186
tabs, Overview pane, 58
Outline, 9, 31
Slides, 9
tabs, ribbon, 5
Animations, 14
customizing, 360
Design, 11
displaying, 5
File, 15
Home, 6, 10
Insert, 11
removing, 360, 361
renaming, 363
Review, 14
Slide Show, 14
Transitions, 13
View, 14
Tag Image File Format. See TIFF
tags, HTML, 374
Taskbar
displaying open programs on, 27
overview of, 4
templates. See also design templates; slide masters
built-in, 18
content, 18
custom, 326
defined, 374
design, 18
displaying, 16
existing presentations as, 18
saving charts as, 208, 213
text in, 103
testing
sounds, 265
videos, 269
text
adding to diagrams, 123
adding to shapes, 137, 140
adding to WordArt objects, 225
aligning, 104
animating, 256
applying attributes to, 105
attaching hyperlinks to, 237
automatically sizing to fit placeholder, 72
centering in cells, 184
capitalization, 105
color, 105
direction, 60
deleting, 69
defining, 70
text colors, 92
text entering on Outline tab, 56
finding/replacing, 84, 86
formatting effects, 110
line spacing, changing, 104
outside of placeholders, 59
placeholders for, 59
promoting/demoting, 58
replacing, 84
rotating, 60, 63
selecting, 67
selecting all in placeholder, 107
shrinking to fit text box, 61
size, 104
on slides, displaying as outline, 9
stacking, 60
in templates, 103
wrapping in text boxes, 61
Text Box button, 59, 62, 117, 140, 213
text boxes, 59
adding to charts, 213
adding to slides, 117
borders, adding, 61, 64
changing effect, 102
changing outline, 101
copying, 60
creating, 66
default font, changing, 66
defined, 374
deselecting, 61
entering/editing text, 60
filling with color, 100
manipulating, 60
moving, 60, 63
multi-line, 59
single-line, 59
sizing, 60
wrapping text within, 61
themes
applying, 13
applying different, 91
defined, 374
live previews of, 90
overview of, 89
saves, 309
setting as default, 306
switching, 90
Themes gallery, 12, 90, 202
Thesaurus, 78, 81-82, 374
Thesaurus button, 81
35mm slides, 152
thumbnails, 12. See also Slides tab
defined, 374
displaying, 9
displaying all together, 31
formatting options, 8
tick-marks
in charts, 129
defined, 374
TIFF file format, 121
times in footers, 153
timings, slide, 335
applying to all slides, 336
defined, 373
overview of, 335
rehearsing, 337
title bars, 4, 374
title slides, 374
titles
adding to slides, 56
animating, 250
defined, 374
ToolBar, Mini
defined, 372
hiding, 351
overview of, 105-106
ToolBar, Quick Access
for active presentation, 366
adding buttons to, 365-366
adding separator to, 367
buttons, adding, 365-366
customizing, 5, 366
defined, 373
moving, 5
moving below ribbon, 366
resetting, 368
separator, adding, 367
ToolBar, View, 374
toolbars
navigation, 175, 176
View Shortcut, 8
trademark symbol. See symbols
transitions
adding animations, 147
adding to presentations, 145, 149
associating sounds with, 148
defined, 374
dynamic content, 146

exciting, 145
presentations, adding to, 145, 149
removing animation, 147
sounds for, 148
subtle, 145
timing, 149
viewing, 148
Transitions tab, 13
Translate button, 83
translating text, 83
transparencies, 152
transparent color in pictures, 196
Trigger button, 255
Trim Video button, 269, 271
Trim Video dialog box, 271
trimming
sounds, 264
videos, 269, 271
Trust Center dialog box, 357
Trust Center settings, 356, 357
trusted locations, setting, 357
turning effect, 145. See also transitions
two monitors, 174

U
underlining text, 105
undo actions, changing default number of, 69
Undo button, 5, 68, 70
undoing editing, 68
ungrouping shapes, 144
updates, automatic in charts, 134
updating pictures automatically, 115
uppercase. See case
user interface. See also ribbon
color scheme, changing, 351
overview of, 10
user name/initials, setting, 351

V
value axes in charts, 129
value axis (y-axis), 129, 374
Video button, 268
video objects, 269
videos
cropping, 272
inserting, 268
looping, 274
playing, 270
rewinding, 269
saving, 343
sound for, 269, 274
starting automatically, 274
testing, 269
trimming, 269, 271
volume, adjusting, 269, 274
from Web sites, 275

Video Styles gallery, 273
Viewer
defined, 372
displaying, 340
viewing color schemes, 92
viewing masters, 313
viewing multiple open presentations, 33
viewing presentation status, 280

views, 9. See also Normal view; Slide Master view;
Slide Show view; Slide Sorter view
Backstage, 5
Handout Master, 30
Master group, 30
Notes Master, 30
Notes Page, 29, 161
Reading, 9, 28, 373
switching among, 29, 33
zooming, 34

View Shortcuts toolbar, 8
View tab, 14
View toolbar, 374
Volume button, 264, 269, 274
volume of sounds, 264, 269, 274

W
Web App, 281
Web browsers, 374
Web page banners
slide size for, 152
presentations, 154
Web sites
jumping to with hyperlinks, 237
videos from, 275
Windows Live SkyDrive, 281
Windows Media Video, 343
Windows Taskbar
displaying open programs on, 27
overview of, 4

Wingdings, 230. See also symbols
wipes, 145. See also transitions
Word handouts, 167
WordArt, 223
WordArt button, 224

WordArt gallery, 224
WordArt objects
adding text to, 225
defined, 374
formatting text in, 224

WordArt Styles gallery, 206
WordArt text, 224
word-by-word animation, 256

Word outlines, importing, 40

worksheet cells
addresses, 129, 369
centering text in, 184
combining, 182, 184
defined, 369
dividing, 182
drawing, 182
formatting, 185
merging, 182, 184
moving between, 182
shading, 187
splitting, 182, 373

wrapping text within text boxes, 61

X
x-axis, 374
XML file formats, 24
XPS file format, 284-285
XPS Viewer, 288

Y
y-axis, 129, 374

Z
z-axis, 374
Zoom button, 34
Zoom dialog box, 34
Zoom In button, 35, 160
Zoom Level button, 8
Zoom Out button, 35
zoom percentage
changing, 34
changing globally, xvi
changing for slides, 30, 35
Zoom Slider, 8, 51
Zoom To Page button, 160
zooming effect, 145. See also transitions
About the Authors

Joyce Cox

Joyce has 30 years’ experience in the development of training materials about technical subjects for non-technical audiences, and is the author of dozens of books about Office and Windows technologies. She is the Vice President of Online Training Solutions, Inc. (OTSI).

As President of and principal author for Online Press, she developed the *Quick Course* series of computer training books for beginning and intermediate adult learners. She was also the first managing editor of Microsoft Press, an editor for Sybex, and an editor for the University of California.

Joan Preppernau

Joan has worked in the training and certification industry for 13 years. As President of OTSI, Joan is responsible for guiding the translation of technical information and requirements into useful, relevant, and measurable training and certification tools.

Joan is a Microsoft Office Master (MOM), a Microsoft Certified Application Specialist (MCAS), a Microsoft Certified Technology Specialist (MCTS), a Microsoft Certified Trainer (MCT), and the author of more than two dozen books about Windows and Office (for Windows and Mac).